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All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby
acknowledged.
Legal Notices
APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
REGARDING THE APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS
REGARDING THE USE OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT
PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.
IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL,
INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE
EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT
APPLY TO YOU. Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action
(whether in contract, tort [including negligence], product liability or otherwise), will be limited to $50.
PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-identified
standards.þ Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, Inc. trademarks are
the property of Pantone, Inc.þ © Pantone, Inc., 2004.
Pantone, Inc. is the copyright owner of color data and/or software which are licensed to Electronics for Imaging, Inc.,þto distribute
for use only in combination with the products, or software of Electronics for Imaging, Inc. þPANTONE Color Data and/or Software
shall not be copied onto another disk or into memory except as part of the delivery of the Electronics for Imaging, Inc., products
or software.
This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
FCC Information
WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by
the manufacturer could void the user’s authority to operate this equipment.
Class A Compliance
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated
in a commercial environment. This equipment generates, and uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference
at his own expense.
Industry Canada Class A Notice
This Class A digital apparatus complies with Canadian ICES-003.
Avis de Conformation Classe A de l’Industrie Canada
Cet appareil numérique de la Classe A est conforme à la norme NMB-003 du Canada.
Class B Declaration of Conformity
This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC
rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation.
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If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.
In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with nonapproved equipment or unshielded cables is likely to result in interference to radio and TV reception. The user is cautioned that
changes and modifications made to the equipment without the approval of manufacturer could void the user’s authority to operate
this equipment.
Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-003.
Avis de Conformation Classe B de l’Industrie Canada
Cet appareil numérique de la Classe B est conforme à la norme NMB-003 du Canada.
RFI Compliance Notice
This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on
system level (to simulate normal operation conditions). However, it is possible that these RFI Requirements are not met under
certain unfavorable conditions in other installations. It is the user who is responsible for compliance of his particular installation.
Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung
der Funkentstörbestimmungen geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen
bei anderen Gerätekombinationen nicht eingehalten werden. Für die Einhaltung der Funkentstörbestimmungen einer gesamten
Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.
Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the
appropriate cables.
Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung
richtiger Ausführungen ist der Betreiber verantwortlich.
Software License Agreement
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE.
License
EFI grants you a non-exclusive license to use the Software and accompanying documentation (“Documentation”) included with
the Product. The Software is licensed, not sold. You may use the Software solely for your own customary business or personal
purposes. You may not rent, lease, sublicense or lend the Software or use the Software in any time sharing, service bureau, or
similar arrangement.
You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) copy for
backup or archive purposes in support of your use of the Software as permitted hereunder. You may not copy the Documentation.
You may not attempt to localize, translate, disassemble, decompile, decrypt, reverse engineer, discover the source code of,
modify, create derivative works of, or in any way change any part of the Software.
The terms, conditions, and restrictions in the License Agreement apply to all bug fixes, patches, releases, release notes, updates,
and upgrades related to the Software.
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Proprietary Rights
You acknowledge and agree that all rights, title and interest, including all intellectual property rights, in and relating to the
Software, Documentation and all modifications and derivative works thereof are solely owned by and shall remain with EFI and
its suppliers. Except for the express limited license granted above to use the Software, no right or license of any kind is granted.
You receive no rights or license under any patents, copyrights, trade secrets, or trademarks (whether registered or unregistered).
You agree not to adopt, register, or attempt to register any EFI trademark or trade name (“EFI Mark”) or any confusingly similar
mark, URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and not to take any
other action which impairs or reduces the trademark rights of EFI or its suppliers.
Confidentiality
The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may,
however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) such
a transfer is authorized under all applicable export laws and regulations, including the U.S. Export Administration Regulations,
(2) you transfer to the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior
versions, component parts, the media and printed materials, and this Agreement); (3) you retain no copies of the Software and
Documentation, including copies stored on a computer; and (4) the recipient agrees to the terms and conditions of this
Agreement.
Remedies and Termination
Unauthorized use, copying, or disclosure of the Software, or any breach of this Agreement will result in automatic termination of
this license and will make available to EFI other legal remedies. In the event of termination, you must destroy all copies of the
Software, Documentation, and all component parts thereof. All provisions of this Agreement relating to disclaimers of warranties,
limitation of liability, remedies, damages, governing law, jurisdiction, venue, and EFI’s proprietary rights shall survive
termination.
Limited Warranty and Disclaimer
EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its
authorized retailer that the Software will perform in substantial conformance to the Documentation when the Product is used as
authorized by EFI’s specifications. EFI warrants the media containing the Software against failure during the above warranty
period. EFI makes no warranty or representation that the Software will meet your specific requirements, that the operation of
the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI
makes no warranty, implied or otherwise, regarding the performance or reliability of any third party products (software or
hardware. THE INSTALLATION OF ANY THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS
WARRANTY. IN ADDITION, USE, MODIFICATION, AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL
VOID THIS WARRANTY.
EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EFI
MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY
OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF THIRD
PARTY RIGHTS.
Limitation of Liability
TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL
DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.
You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA
95110-2704 (“Adobe”) is a third-party beneficiary to this agreement to the extent that this agreement contains provisions which
relate to your use of any software, font programs, typefaces, and/or trademarks licensed or supplied by Adobe. Such provisions
are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to EFI. ADOBE WILL HAVE NO LIABILITY
WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.
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Export Controls
EFI’s Products are subject to U.S. export laws and regulations, including the U.S. Export Administration Regulations, as well as
foreign export laws and regulations. You agree that you will not use, distribute, transfer, export, or re-export any portion of the
Product or the Software in any form in violation of any applicable laws or regulations of the United States or the country in which
you obtained them.
U.S. Government Restricted Rights:
Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR
12.212 or DFARS 227.7202-3 -227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as
set out in FAR 52.227-14, Restricted Rights Notice (June 1987) Alternate III(g)(3)(June 1987) or FAR 52.227-19 (June 1987).
To the extent any technical data is provided pursuant to the Agreement, such data is protected per FAR 12.211 and DFARS
227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS
252.227.7015 (November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced
agency regulations are modified or superceded, the subsequent or equivalent regulation shall apply. The name of the Contractor
is Electronics for Imaging.
General
The rights and obligations of the parties related to this Agreement will be governed in all respects by the laws of the State of
California exclusively, as such laws apply to contracts between California residents performed entirely within California. The
United Nations Convention on Contracts for the International Sale of Goods and any other similar convention does not apply to
this Agreement. For all disputes related to this Agreement, you consent to the personal and exclusive jurisdiction and venue of
the state courts in San Mateo County, California and the federal court for the Northern District of California. This Agreement is
the entire agreement held between us and supersedes any other communications or advertising with respect to the Software. If
any provision of this Agreement is held invalid, such provision shall be deemed modified to the extent necessary to be enforceable
and the other provisions in this Agreement shall continue in full force and effect.
If you have any questions, please see EFI’s web site at www.efi.com.
Electronics for Imaging
303 Velocity Way
Foster City, CA 94404
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About the Documentation

This manual is part of a set of Fiery documentation that includes
the following manuals for users and system administrators. Most
are available as Acrobat PDF (Portable Document Format) files on
the User Documentation CD.
• The EFI User Software Installation Guide describes how to install
software from the User Software CD to enable users to print to
the Fiery, and also describes setting up printing connections to
the Fiery.
• The EFI Configuration Guide explains basic configuration and
administration of the Fiery for the supported platforms and
network environments. It also includes guidelines for setting up
UNIX, Windows NT 4.0/2000/Server 2003, and Novell NetWare
servers to provide printing services to users.
• The EFI Printing Guide describes the printing features of the
Fiery for users who send jobs from their computers.
• The EFI Color Guide provides information on managing the color
output of the Fiery. It explains how to calibrate your Fiery and
take advantage of the ColorWise® color management system, as
well as features in ColorWise Pro Tools™.
• The EFI Color Reference addresses concepts and issues
associated with managing color output of the Fiery and outlines
key workflow scenarios. In addition, it offers information on
printing color documents from popular Microsoft Windows and
Apple Mac OS applications.
• The EFI Job Management Guide explains the functions of the job
management utilities, including Command WorkStation™,
Command WorkStation LE™, and DocBuilder Pro™, and how you
can use them to monitor and control jobs on the Fiery. This
manual is intended for an operator or administrator, or a user
with the necessary access privileges, who monitors and
manages job flow, performs color calibration, and troubleshoots
problems that may arise.
• Release Notes provide last-minute product information and
workarounds for some of the problems you may encounter.
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About this guide

This guide provides a reference for information about optimizing
color printing with the Sharp AR-C360P and improving color
quality and performance for all printer models. Specific features
and options may vary, depending on the Sharp AR-C360P model
at your site.

About this guide
This guide provides an overview of general color concepts, with a
specific focus on color management for print output. It describes
multiple scenarios (called workflows) during which color
information can be specified, and makes recommendations about
when to use each type of workflow. It also provides application
notes that explain how to print to the Fiery from popular
Microsoft Windows and Apple Mac OS applications.
The Glossary at the back of this guide defines terms and
concepts—for example, output profile—that appear throughout
this manual. Color terms and concepts such as “RGB data,” “color
space,” “spot color,” “gamut,” and “source profile” are used
throughout this guide. If you are new to desktop color, or if any
terms are unfamiliar, consult the Glossary near the end of this
guide.

For additional information
For additional information about the topics discussed in this guide,
see:
• Color Guide—for detailed information about the color printing
options and settings available with your Fiery, as well as the
ColorWise® color management system built into your Fiery.
• Printing Guide—for information about how to set the ColorWise
print options.
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• User Software Installation Guide—for information about the
software provided with your Fiery, including sample color
reference pages used to verify print results.
• Job Management Guide—for information about performing color
management tasks and using ColorWise Pro Tools™.
For general information about printing in color, see Appendix A
and the sources in the Bibliography.
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Chapter 1:
Overview
of Color
Management
Concepts

To create successful color documents and presentations, you can
take advantage of the features of color management software as
they are implemented by the Fiery and on your desktop computer.
This chapter is devoted to various elements of color management
that contribute to predictable color results.

Understanding color management systems
A color management system (CMS) is a “translator” between the
color space of the source device (for example, the monitor or a
scanner) and the color space of the destination device (for
example, the printer). It compares the color space in which the
source image was created to the color space in which the job will
be output, and adjusts the colors in the document to maintain
consistency across different devices. A CMS typically uses a
device-independent color space, such as CIELAB, as its
intermediate color space. To perform its translation, a CMS needs
information about the color space of the source image and the
gamut of the printer. This information is provided through profiles,
often created by the makers of the computer monitor or printer.
The end product of a CMS conversion is a printed document or an
image file in the gamut of a particular printer.
There has been progress toward standardization in the field of
digital color management systems. Both the Windows and Mac OS
operating systems support an industry standard format developed
by the International Color Consortium (ICC). This ICC format is
implemented on Windows computers as Image Color Matching
(ICM) and on Mac OS computers in ColorSync. More and more
software developers are also incorporating color management
systems into high-end applications. The Fiery color management
system, ColorWise, supports this standard profile format.

How color management works
Before you can print a color document, the color data in it must be
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converted to the gamut of the printer. Whether performed by the
Fiery or a host-based CMS, the process of converting color data
for a printer is the same: the CMS interprets RGB image data
according to a specified source profile and adjusts both RGB and
CMYK data according to a specified output profile, also called a
destination profile by some color management systems.
Color management system

Source
profile

Input data

Output
profile
Deviceindependent
color space

Printed data or file

The source profile defines the RGB color space of the image’s
source—characteristics such as the white point, gamma, and the
type of phosphors used. The output profile defines the gamut of
an output device, such as a printer. The Fiery (or the host-based
CMS) uses a device-independent color space to translate between
the source color space and the color space of the output device.
The Fiery allows you to specify default and override settings for
the source color space information and the output profile
information (see the Color Guide Chapter 1). When you use these
settings, you do not need to use the features of other color
management systems. Your Fiery software includes ICC profiles
for use with other color management systems, although conflicts
may arise when the Fiery CMS is used in conjunction with a host
CMS.
You can also use color management systems to adjust color data
to the gamut of an output device other than the one to which you
are printing. This process of simulating another output device is
commonly used for proofing jobs that will be printed on an offset
press. The Fiery simulation feature is described in detail in
Chapter 1 of the Color Guide.
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The type of print job and the final output device—Fiery or offset
press—determines the workflow that allows you to achieve the
best results. For information about choosing workflows, see
“Using Color Management Workflows” on page 2-19.

Using ColorWise and application color
management
The Fiery color management system, ColorWise is designed to
provide both casual and expert users the best color output for a
variety of purposes. Several applications also provide their own
color management system. This guide describes how to optimize
print output using both ColorWise color management and
application color management.
The Fiery can intelligently manage the printed appearance of RGB,
CMYK, and spot colors. You can allow the Fiery to manage color
for most color printing jobs without adjusting any settings.
A desktop (host-based) color management system uses ICC
profiles to convert colors from one device gamut to another (see
Appendix A). The color data is converted when it passes from one
application to another or when the job is sent to the printer; thus,
the processing occurs on your computer, as opposed to the Fiery.
Conventional color management systems typically address only
color conversions, and they occupy your computer processor.
When you use ColorWise, jobs leave your computer faster, and
are processed more quickly on the Fiery.
The advantages to ColorWise color management versus desktop
(application) color management include:
• Relieving your computer from performing additional processing.
Delaying color conversions until the color data reaches the Fiery
frees your computer so that you can continue working, and color
conversions on the Fiery are, in most cases, much faster than
similar conversions on a host computer.
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• Eliminating the potential for undesirable color managementrelated conflicts, such as iterative color conversions and
inconsistent color. The Fiery applies global corrections to specific
groups of RGB, CMYK, and spot colors to avoid such conflicts.
• Accepting RGB files in addition to larger CMYK files from
applications, which minimizes network traffic and enables jobs
to print faster.
ColorWise uses ICC profiles to convert colors to the device gamut
or simulate other devices, such as an offset printing press.
ColorWise manages color conversions for all users printing to the
Fiery from Windows and Mac OS computers. It allows users to
follow a simple workflow with minimal intervention using robust
default settings, while giving advanced users the control and
precision they need.

Using ColorWise color management tools
Your Fiery user software includes several types of color reference
pages that allow you to see the range of colors that can be printed
on your printer. For predictable color, use the color reference
pages when defining the color in your document.
The resources available are:
• RGB Color Reference—a Microsoft Word file and a Microsoft
PowerPoint file that allow you to view the colors available in the
standard palettes of office applications and to see how those
colors print on the Fiery (see “Using color matching tools with
office applications” on page 3-29).
• CMYK Color Reference—an 11-page downloadable PostScript file
of CMYK color patches (see “Using the CMYK Color Reference”
on page 4-34).
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• Process Simulation of PANTONE Solid Coated Colors—a 19-page
downloadable PostScript file of color patches showing CMYK
equivalents of PANTONE Coated colors. This file prints differently
depending on the setting of the Spot Color Matching option
(see “Using the PANTONE reference” on page 4-35).
In addition, you can print RGB, CMY, and PANTONE color charts
from the Fiery.
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Chapter 2:
Using Color
Management
Workflows

A workflow is the path a print job follows from creation to
destination. In the workflow of any job, there are various points at
which decisions are made about how to define, use, and translate
color. The choices made, and the point at which they are made,
impact the color output produced.
This chapter introduces issues with color management in specific
desktop applications and discusses the interaction between those
applications and ColorWise color management.

Understanding workflows
The term “workflow” is used to describe the path a job follows
from its creation in a desktop application to final printed output.
The Fiery supports a variety of workflows with different levels of
complexity. There are several points at which color management
can be performed on a job (see the illustration on page 2-20). The
information provided at each step (for example, the type of color
used) impacts the workflow of the job.
Note: Always consider the complexity of the workflow. Every time

colors are converted, performance and color accuracy are
affected. A workflow with a minimum number of steps minimizes
the risk of error.
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DOCUMENT

C M
Y K

Spot

R
G B

Application CMS: Off
Disable the color management options
provided by the application to ensure that the
Fiery receives color data properly and prints
it accurately. For information, see the
documentation provided with your
application.
Select colors based on the desired output
(see “Choosing colors” on page 2-23).

SAVE AS (File Format)
EPS recommended

PRINT
Set ColorWise print options

Select file format based on the desired
output. EPS data is not manipulated.

Use ColorWise Color Management as
described in this guide and the Color Guide
Chapter 1.
Printer driver color options: Off
Do not use the color management options
provided by the printer driver. For more
information, see the Printing Guide
Appendix A.
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Calibration

Color Server

Device
maintenance

Calibrate as described in the Color Guide.
Perform regular maintenance as
recommended by the printer manufacturer.
Use the paper stock, toner, and other
materials recommended by the printer
manufacturer.

Best output
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Standard recommended workflow
The Fiery controller is highly optimized for the Sharp AR-C360P.
ColorWise addresses issues unique to your printer, including
screens, individual toner response, interactions among toners,
natural smoothness of blends, and the capability to render spot
and custom colors. The Fiery distinguishes text and graphics from
image elements, so that black channel information is preserved
while parameters used for CMYK color separations are maintained.
The recommended standard color workflow uses ColorWise
calibration and color management. The Fiery comes into play near
the end of the color workflow.
For this workflow:
• Bypass any color management in the applications and printer
drivers.
This ensures that the colors you selected reach the Fiery and
ColorWise
in a usable form. Keep in mind, however, that ColorWise fully
supports color management from applications and printer
drivers (see “Using ColorWise and application color
management” on page 1-16).
• Set the CMYK Simulation Profile option in ColorWise to match
the CMYK color space used in the application to select the
colors. Any CMYK Simulation setting (except Match Copy, if
available) applies calibration, so the response of the printer will
appear to be stable.
The recommended values for CMYK Simulation are SWOP in the
U.S., Euroscale in Europe, and DIC in Japan—choices that reflect
the color standard for each region. If colors have been selected
specifically for your calibrated Fiery, set CMYK Simulation to
None.
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• Set other ColorWise print options as appropriate. For a list and
descriptions of ColorWise print options that affect CMYK, RGB,
spot, and other colors, see the Color Guide Chapter 1.

Choosing colors
When working with color materials, whether they are
presentations, illustrations, or complicated page designs, you
make aesthetic decisions about the colors you use. After you set a
goal, you must make the best use of the capabilities of your Fiery
to realize your design in print. Your color printing system becomes
an ally in this creative process to the extent that results are
predictable:
• If you designed a poster to print on the Fiery, you want the
printed colors to match the design specification.
• If you are printing presentations on the Fiery, you want to
preserve the vivid colors you see on your monitor.
• If you are working with color that is to be printed on an offset
press, you want the Sharp AR-C360P output to match other
prepress proofs or PANTONE color swatch books.
The colors that you define when creating a file in an application,
and the color management tools within the application that you
use, impact how the file is processed (workflow) and the final
output you can expect.
Use color management to control color output by:
• Selecting a color model—different types of applications use
different color models. The color model you select, and whether
or when data is converted from one color model to another,
influences the final color output.
• Optimizing for output type—the type of final output influences
your color and application choices.
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• Using color matching tools—the Fiery provides several tools to
preview colors available on a device and define them within an
application.

Understanding color models
Colors can be defined in several different color models, the most
common being RGB, CMYK, and the spot color matching system
(such as PANTONE). Depending on the application you use, you
may or may not have a choice of the color model.
• RGB colors are used when you take output from an RGB device
such as a digital camera or a scanner. Another use of the RGB
color model is for displaying colors on a monitor.
• CMYK colors are what most printers use.
• Spot colors, such as PANTONE, are special inks manufactured to
run on an offset printing press. Spot colors can be simulated
using CMYK toners (also known as process color inks). With the
Spot Color Matching print option, you can determine how spot
colors are printed at the Fiery:
Spot Color Matching On uses color tables built in the Fiery to
simulate the spot color with the closest equivalent available
using the CMYK toners of the Sharp AR-C360P.
Spot Color Matching Off instructs the Fiery to simulate the spot

color using CMYK equivalents defined by the spot color
manufacturer. These are the same CMYK values used by
applications that include spot color libraries. This CMYK
combination is then printed with the CMYK Simulation setting
you choose, such as SWOP or DIC.
The color model used by your application determines the methods
available for choosing colors, as well as the way color data is
transmitted to the Fiery:
• Office applications, such as presentation software,
spreadsheets, and word processing programs, use the RGB color
model. They typically transmit only RGB data to the Fiery.
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• Illustration applications use both the RGB and CMYK color
models, but typically transmit only CMYK data to the Fiery.
• Pixel-editing applications use both the RGB and CMYK color
models. They can transmit either RGB or CMYK data to the
Fiery.

Optimizing for output type
The Fiery can be used for on-demand color printing and for color
proofing.
On-demand color printing refers to those jobs for which the Sharp
AR-C360P is the final print device. Printing jobs to the Fiery in
preparation for printing on an offset press is referred to as color
proofing. Both types of Fiery print jobs can use RGB, CMYK, and
spot colors.
Characteristics of on-demand
jobs

Characteristics of offset proofs

Bright, saturated colors are often
desirable.

Require the printed colors to
match those from another set of
CMYK printing conditions.

Colors are achieved using the
full range of colors available,
referred to as the full gamut of
the printer or, more simply,
device CMYK.

Colors that are specified for an
offset press require CMYK
simulation that is optimized for
proofing on the printer.

Note: The term on-demand applies to producing printed output

when it is needed. You may be familiar with the term short-run,
which usually applies to the volume of a printing task. Although
these terms do not mean exactly the same thing, the term
on-demand in this manual applies also to short-run printing
scenarios. Because you can print as many pages as you need and
can reprint jobs quickly, the Fiery performs equally well in either
environment.
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The type of printing you plan for the document—on-demand color
printing on the Sharp AR-C360P versus color proofing for eventual
printing on an offset press—determines the way you define colors,
as well as the print option settings you choose.
• For on-demand color printing on the Sharp AR-C360P, use any
application and define colors in either RGB or CMYK. If your
application supports it, you can also choose colors from the
PANTONE color library. Choose the appropriate settings for print
options affecting color output (for descriptions of the
print options, see the Color Guide Chapter 1).
• For color proofing, use a PostScript-defined color in CMYK or
choose colors from color libraries such as the PANTONE color
library. Placed images can also be defined in RGB or CMYK.
Choose the appropriate settings for print options affecting color
output (see the Color Guide Chapter 1).
Note: The Fiery allows you to use RGB or CMYK data when printing

proofs for an offset press run. However, sending data to an
imagesetter usually requires CMYK data.

Maintaining color accuracy
For the colors you see on your monitor to match those on your
printed output, they must go through color management,
including precise calibration of your monitor and Fiery. If viewing
colors on the monitor is critical, consider using a professional
profiling software package and instrument, such as the EFI Color
Profiler, to create a monitor profile. A monitor profile enables
application to compensate for the color behavior of the monitor
when displaying images. As a result, colors previewed on the
monitor more closely match colors in your printed output.
If you are not equipped or inclined to maintain accurate monitor
color management, you can opt for an easier approach.
Determine which is more important to you—printed colors or onscreen colors.
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• If displayed colors are more important, trust your eyes and your
monitor. Visually select colors on your monitor, but be aware
that colors will be optimized only for your monitor. When the
document is opened on other monitors, the colors may look
different. And even though printed colors may not match those
on your monitor, they will still print to the Fiery with good
results.
• If printed colors are your priority, choose colors from printed
samples. By using sample colors, you ensure your printed
output remains consistent, regardless of how the colors appear
on different monitors. Print the palette of available colors from
business applications and select colors from the printed
samples. Color reference files are included on the User Software
CD. (For more information, see“Using color matching tools with
office applications” on page 3-29 and “Using color matching
tools with PostScript applications” on page 4-34.) You can also
print color charts from the Fiery and select colors by name or
number from the printed samples. Advanced applications allow
you to define colors in the easier-to-control spot and CMYK color
spaces. For more advice on color selection, see “Choosing
colors” on page 2-23.
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Chapter 3:
Managing
Color in Office
Applications

The ColorWise color management system provides complete color
management for jobs printed from office applications and other
applications that do not generate PostScript. This chapter provides
instructions for printing color documents from Graphics Device
Interface (GDI) and QuickDraw applications, such as presentation,
spreadsheet, and word processing applications. Use these
instructions with the Microsoft Office applications.

Using office applications
The Fiery must receive PostScript instructions to print an image or
a document. Many applications do not create these PostScript
instructions, relying on the printer driver to create them. Included
in this category are most word processing, spreadsheet, and
presentation graphics applications. These applications use
Windows GDI to display and print when running Windows, and
Apple QuickDraw to display and print when running Mac OS. We
refer to these GDI and QuickDraw applications as “office
applications.”
All office applications handle color similarly, using the same RGB
color model used for the color monitor. Most office applications
allow you to choose colors from a palette of preselected colors;
some allow you to add new colors to the palette using a color
picker. Although some applications allow you to specify color using
the CMY, HSL, and HSV color models, these applications always
send RGB color data to the Fiery.
(An exception to this is a CMYK EPS file placed in the document,
which is sent as CMYK data.)
When working with color in office applications, consider the
following:
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• The range of colors that can be displayed in RGB on your
monitor is much larger than the range of colors that can be
printed on your printer. When you print the document, out-ofgamut RGB colors are mapped to the colors your printer
can produce.
• Office applications send only RGB data to the Fiery. You control
the rendering style of the color conversion with your selection of
a CRD.
Each CRD uses a different color rendering style and has a
different way of mapping unprintable colors to the color gamut
of your printer. For more information on color rendering styles,
see the Color Guide Chapter 1.

Using color matching tools with office
applications
Your Fiery user software includes two RGB color reference pages,
a Microsoft Word file and a Microsoft PowerPoint file. You can print
these files using different CRDs to see how the colors appear
when printed to the Fiery. For best results, print the color
reference page using the same print options you plan to use for
your final document. Select the colors you want to use from the
printed version of the RGB color reference page and use those
colors in your document.
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RGB Color Reference (Microsoft PowerPoint)

Working with office applications
Before printing from these applications, make sure the
appropriate printer driver and the Fiery PPD are installed on your
computer, as described in the User Software Installation Guide.

Defining color
Office applications use the RGB color model. The only way to use
CMYK or PANTONE colors is to define them in EPS format files
with an illustration or page layout application, and then place
these files in Microsoft Office documents. Colors in EPS files are
preserved until they reach the Fiery (assuming no PostScript Color
Management information was included).
Office applications use low resolution to display EPS files, but the
EPS images are printed at full resolution. In general, use EPS files
only when RGB colors are impractical in your specific workflow.
EPS files are useful when using large or complex images that must
be printed at full resolution or exceed the memory allocation of
some Microsoft Office applications.
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Working with imported files
Your application may allow you to import a variety of file formats.
If you encounter printing problems when using other imported
file formats such as TIFF and PICT, EPS files are recommended.
Note: If you are unable to import EPS elements, it may be

necessary to perform a “custom install” of your Microsoft Office
applications.
Even when there are no user-defined color management options
within office applications, color conversions do occur when you
import images or page elements that were not defined in RGB. To
avoid such conversions with imported files, use the EPS file format
for non-RGB artwork that is to be imported into office
applications.
All RGB images placed in a document are affected by the settings
you choose for the RGB Source and Rendering Style print options.

management)

Mixing imported image types (Advanced color
If you place multiple RGB images—mixed non-photographic and
photographic—into an office application file, a single CRD may not
optimize output for all the images. In this case, you may want the
photographic images to bypass the CRD altogether. To accomplish
this, open the photographic image in CMYK mode with a pixelediting application, such as Photoshop, and perform color
correction. Save the image as a Photoshop EPS and import it into
the document.

Selecting options when printing
There are few differences among office applications with regard to
Fiery printing. To specify print options and color management
settings, follow the instructions in the Color Guide Chapter 1. To
specify these options, you must use a PostScript Level 2 (or later)
printer driver, such as an Adobe PostScript Printer Driver.
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Because office applications send RGB data to the Fiery, your
choice of RGB Source and Rendering Style settings are important.
Specify the appropriate CRD for the desired color effect (see the
Color Guide Chapter 1).

Output profiles
All color data in the job is affected by the output profile on the
Fiery. This profile may be the one designed for your device and
shipped with the Fiery, or it may be a custom profile created at
your site (see the Color Guide Chapter 1). If necessary, print the
Test Page to see which profile is the active default on the Fiery.

Ensuring color accuracy when you save a file
Take the following steps to ensure color accuracy:
• When saving EPS files, do not include PostScript Color
Management information. This minimizes the risk of conflicting
data and multiple color conversions. PostScript Color
Management causes your CMYK and RGB colors to be
interpreted by the Fiery as though they were supplied in the Lab
color space and, as a result, processed by CRDs, rather than
your simulation settings.
• Include ICC color information in files. ColorWise does not
conflict with this information, and such data is useful for
identifying the specific color space used by your files.
• Do not include halftone and transfer functions.
• Turn off color management in the printer driver.
On Windows computers, if the printer driver offers Image Color
Matching options, select Printer Image Color Matching.
On Mac OS computers, set the printer driver to include no color
management commands at print time (see the Color Guide
Chapter 1).
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Chapter 4:
Managing
Color in
PostScript
Applications

This chapter provides guidelines for using applications that have
the ability to write their own PostScript, such as some page
layout, illustration, and pixel-editing applications. For information
about using specific applications, see “Managing Color in Adobe
Photoshop” on page 5-42, “Managing Color in Page Layout
Applications” on page 6-56, or “Managing Color in Illustration
Applications” on page 7-72.

Working with PostScript applications
Most applications used for illustration, pixel editing, and page
layout can create the PostScript information they send to a
PostScript printer or save in PostScript files. Illustrator,
Photoshop, PageMaker, QuarkXPress, and Macromedia FreeHand
are all PostScript applications.
PostScript applications work with color in many different ways.
Most allow you to choose process colors (by entering percentages
for cyan, magenta, yellow, and black), as well as named
colorsfrom a spot color system, such as PANTONE. When you print
composites, these applications send process-color equivalents for
named spot colors to the Fiery. In some applications, you can also
choose colors using the RGB, HSB, HSL, or other color models.
Generally, PostScript applications send color information to the
Fiery as CMYK data. An exception to this is an RGB image placed
in a document, which is sent directly to the Fiery (unless you
specify special color management settings in the application). In
addition, some PostScript applications that allow you to define
colors in RGB or other color models also send data to the Fiery in
those color spaces.
Color controls in PostScript applications are typically designed for
printing on an offset press, and some adjustments are required
for printing to the Fiery. Displayed versions of colors you choose
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in these applications may not match Sharp AR-C360P output
exactly, and named colors may not print accurately on the Sharp
AR-C360P, since these colors typically require custom inks.

Using color matching tools with PostScript
applications
With PostScript applications, you can work with colors created
with any of the color models supported by the application. All
PostScript applications support CMYK; some also support RGB and
other color models based on monitor display values. PostScript
applications also allow you to choose named colors using one or
more color libraries, such as PANTONE (see page 4-35).

Using swatch color matching tools
Your Fiery user software includes several color reference pages
(see page 1-17). By choosing colors from these reference pages,
you ensure that you get the same color from your Sharp ARC360P. For best results, calibrate the Fiery before printing the
reference pages.
Note: We highly recommend that you use swatch color matching

to ensure predictable color printing results with the Sharp ARC360P or match your Sharp AR-C360P output to colors produced
by other printers.
Note: Swatch color matching does not match monitor colors to
printed colors. For this, you must use a color management system
and calibrate your monitor.

Using the CMYK Color Reference
Use the CMYK Color Reference included with your Fiery user
software to see how various cyan, magenta, yellow, and black
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combinations look when printed on your Sharp AR-C360P.

To print the CMYK Color Reference, download the file to the Fiery.
The printed pages display groups of color patches in graduated
combinations of yellow, magenta, and cyan, and smaller patches
that include 25%, 50%, and 75% black. Refer to these pages to
pick colors and specify process color values in your application.
For the location of the file on the EFI Utilities CD, see the User
Software Installation Guide.

Using the PANTONE reference
Use this reference (Process Simulation of PANTONE Solid Coated
Colors) included with your Fiery user software to help ensure
predictable results with colors chosen from the PANTONE color
library.
The information printed by this reference depends on the Spot
Color Matching setting.
• Spot Color Matching On—Prints swatches that simulate the spot
color with the closest equivalent available using the CMYK toners
of the Sharp AR-C360P. The equivalent PANTONE color name/
number is printed below each swatch.

Sharp AR-C360P EFI Color Reference Guide - 35

4

4-36 Managing Color in PostScript Applications

• Spot Color Matching Off—Prints swatches of the CMYK
equivalents of PANTONE colors as defined by PANTONE. (These
are the same CMYK values defined in applications that include
PANTONE libraries.) The CMYK values used to produce the color,
as well as the PANTONE color name/number, are printed below
each swatch.
To print the reference, download the file to the Fiery. For the
location of the file on the User Software CD, see the User Software
Installation Guide. If the default Spot Color Matching setting on
the Fiery is not the setting you want to use for printing the
PANTONE colors, download the file to the Hold queue, and then
override the Spot Color Matching setting using a job management
utility, such as Command WorkStation (see the Job Management
Guide).
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Defining colors
The methods and options available for defining colors depend on
the type of PostScript application that you are using.

Color
model

Application
type

Color definition notes

Photoshop

In Photoshop you can choose colors with various
color models, including HSB, CIE Lab, RGB, and
CMYK.

Page layout
application

Page layout applications generally use the CMYK
color model. Some allow you to define colors
with other color models and may be able to send
that data to the Fiery in those other color
models. Generally, however, CRDs (which affect
only RGB data) do not affect colors defined in
page layout applications.
For predictable results with CMYK colors, use the
CMYK Color Reference when defining colors in
page layout applications (see “Using color
matching tools with PostScript applications” on
page 4-34).

CYMK
Illustration
application

All illustration applications use the CMYK color
model. Although you may be allowed to define
colors using other color models, these
applications generally send only CMYK data to
the Fiery.
For predictable results with CMYK colors, use the
CMYK Color Reference pages when defining
colors (see “Using color matching tools with
PostScript applications” on page 4-34).
Different versions of Illustrator support color
models slightly differently (see “Note about color
models in Adobe Illustrator” on page 7-72).
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Color
model

Application
type

Color definition notes

Photoshop

Choose colors in Photoshop with various color
models, including HSB, CIE Lab, RGB, and CMYK.

Page layout
application

If the application allows you to define colors in
RGB, determine whether it converts the RGB
data to CMYK before sending it to the Fiery. If it
does, this will determine which ColorWise print
options affect your job.
For example, if the application converts RGB
black (defined in the document as R0%, G0%,
B0%) to four-color CMYK black when it sends the
job to the Fiery, the option you select for the
Pure Black Text/Graphics print option has no
effect when you print the job.

RGB
Illustration
application

If you define colors in RGB and print directly
from the application, the application converts the
RGB data to CMYK before sending it to the Fiery.
This conversion by the application determines
which ColorWise print options affect your job.
For example, if the application converts RGB
black (defined in the document as R0%, G0%,
B0%) to four-color CMYK black when it sends the
job to the Fiery, the option you select for the
Pure Black Text/Graphics print option has no
effect when you print the job.

Photoshop
Spot
Colors

Page layout
application
Illustration
application

Choose named colors from the PANTONE
color library (see “Using the PANTONE reference”
on page 4-35). For best results, use the color
definition methods described in “Using swatch
color matching tools” on page 4-34.
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Working with imported images
You can import images into documents created in illustration
applications (such as Illustrator) and page layout applications
(such as QuarkXPress). The recommended formats for images
imported into page layout documents are EPS (or EPSF) and TIFF.
If you encounter a problem using a TIFF format image, use the
EPS file format. Support for importing other file formats may be
provided by individual applications.
All RGB images placed in a document are affected by the
RGB Source and Rendering Style settings. The ColorWise color
management system applies the specified RGB Source setting to
all RGB data and then uses the specified Rendering Style (CRD) to
perform a color conversion. An exception to this occurs if you
assign ICC profiles to RGB images using the application’s color
management tools (see the following section). In this case, the
application performs the color conversion of the image and sends
CMYK data to the Fiery.
Note: To take advantage of RGB Source and Rendering Style

settings for images imported into QuarkXPress, save images in
the EPS format or use the Quark PrintRGB XTension, which
outputs RGB TIFF image files without converting them to CMYK.
Mixing image types (Advanced color management)
If you place multiple RGB images—mixed non-photographic and
photographic—into a file, a single CRD may not optimize output
for all the images. In this case, you may want the photographic
images to bypass the CRD altogether. To accomplish this, separate
the image to CMYK data with a pixel-editing application, such as
Photoshop, and perform color correction. Save the file as EPS or
TIFF format and import it into the document.
If your application supports this feature, you can save the RGB
image in TIFF format and assign it an ICC profile and rendering
intent when you import it into the document.
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Using CMYK simulations
You can specify a CMYK Simulation profile and a CMYK simulation
method for a job using the CMYK Simulation Profile and CMYK
Simulation Method print options (see the Color Guide Chapter 1).
The CMYK Simulation setting affects all CMYK color data sent by
the page layout or illustration application. It can also affect RGB
data sent to a page layout application if RGB Separation is set to
Simulation.
• If the document contains CMYK graphics that were separated for
an offset press standard, apply the corresponding CMYK
Simulation setting. For example, for graphics separated for
SWOP, choose SWOP as the CMYK Simulation setting.
If you print separations to the Fiery and choose to use the
Combine Separations feature in conjunction with Full
Simulation, the result may not match that of the same page
printed as composite.
• If the document contains CMYK graphics that were separated
according to the color characteristics of a custom ICC profile
(not a press standard profile), specify the corresponding profile
as the CMYK Simulation Profile setting on the Fiery.
For more information on downloading CMYK Simulation profiles to
the Fiery with ColorWise Pro Tools, see the Color Guide Chapter 3.

Using application-defined halftone screens
If your site has installed the Fiery Graphic Arts Package (not
available for all Fiery models), you can define halftone screens
from several PostScript applications and use them when printing.
The results vary depending on the application.
To define a halftone screen, use the application to adjust the
Frequency and Angle values of the halftone screen. For
applications that use the Fiery default (InDesign, FreeHand,
QuarkXPress, and Illustrator 10), the ink dots are round; for
applications that define their own shape and do not use the Fiery
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default (PageMaker, Photoshop, and Illustrator 9),the halftone
dots may be a different shape. When you print the job, choose
Application Defined for the Halftone Screen print option.
The Frequency and Angle settings in the Application Defined
halftone screen are used regardless of whether the setting for
Combine Separations is set to On or Off. For special instructions
for printing separations with Photoshop, see “Selecting options
when printing” on page 5-49,
Note: In general, using halftone screens is not recommended

because the print output will have visible dots of toner rather than
smooth blends. Use halftone screens only when necessary to
achieve a specific style of print output.

Ensuring color accuracy when you save a file
You can take the following steps to ensure color accuracy:
• When saving EPS files, do not include PostScript Color
Management information. This minimizes the risk of conflicting
data and multiple color conversions. PostScript Color
Management causes your CMYK and RGB colors to be
interpreted by the Fiery as though they were supplied in the Lab
color space and, as a result, processed by CRDs, rather than
your simulation settings.
• Include ICC color information in files. ColorWise does not
conflict with this information, and such data is useful for
identifying the specific color space used by your files.
• Do not include halftone and transfer functions.
• Turn off color management in the printer driver.
On Windows computers, if the printer driver offers Image Color
Matching options, select Printer Image Color Matching.
On Mac OS computers, set the printer driver to include no color
management commands at print time (see the Color Guide
Chapter 1).
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Chapter 5:
Managing
Color in Adobe
Photoshop

This chapter covers features of Adobe Photoshop versions 7.x and
6.x for Windows and Mac OS. The illustrations show Mac OS dialog
boxes, but the information and instructions apply equally to the
Windows version of Photoshop.
Because Photoshop uses a sophisticated color management
system, you should perform some color management tasks before
you use Photoshop.

Specifying color settings
The following sections outline the recommended color settings for
Photoshop in a Fiery workflow. These color settings include:
Working Spaces—Default color spaces to use when working with

RGB and CMYK documents. ICC color profiles describe the gamut
and color characteristics of these working spaces.
Color Management Policies—Instructions that tell Photoshop what

to do when it encounters color data from a color space other than
the specified working space.

Configuring Photoshop color settings
Photoshop uses a sophisticated color management system that
handles document colors for a variety of color-managed
workflows. By customizing color settings, you specify the amount
of color management you want to use while working in Photoshop.
To specify color settings for Photoshop
1. Choose Color Settings from the Edit menu.

The Color Settings dialog box appears.
2. Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.
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3. Choose the desired working space profile for each color mode in
the Working Spaces area.

A working space specifies the color profile for documents that
have no color profile associations or for documents that are newly
created. It also defines color space of a document converted to
RGB, CMYK, or Grayscale color modes, and for spot colors in a
document.
Choose an appropriate ICC profile to embed when saving a file for
each color space. Use the following guidelines for specifying
working spaces:
• For RGB, choose the profile for the default RGB color space used
by the Fiery. In most cases, this is EFIRGB. (For information
about installing the EFIRGB profile, see the User Software
Installation Guide.) Consider sRGB if you usually view images on
a generic PC monitor or rely on a Windows operating system
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to manage color on your monitor. If you choose sRGB as a
working space, you must print with the ColorWise RGB Source
option set to sRGB. New RGB documents you create in
Photoshop will use this working space.
Note: EFIRGB is set as the default RGB source color space on the

Fiery. No matter what RGB space you select, make sure it is
available on the Fiery. For more information on downloading RGB
source profiles to the Fiery, see theColor Guide Chapter 3.
• For CMYK, choose a profile that describes your target press
(such as SWOP) if you are a prepress user. If you are an office
user printing final output, choose an output profile that
describes the Sharp AR-C360P. To use a device-specific output
profile, you must first upload the profile from the Fiery to your
computer (see the Color Guide Chapter 3). New CMYK
documents you create in Photoshop will use the specified
working space.
• For guidelines on specifying Gray and Spot working spaces, see
your Photoshop documentation.
4. In the Color Management Policies area, choose policies for
handling documents without embedded profiles or with
embedded profiles that differ from the working space.

Unless you are an advanced color user, choose Off from the RGB,
CMYK, and Gray menus. If you specify a color management policy
and open a document in an environment with a different working
space than the one in which it was created, you may encounter
problems. The profile embedded in a document may be
overwritten if it differs from the specified working space (although
the numeric color values in the document are preserved).
5. If you do not choose Off for the Color Management Policies, select
Profile Mismatches: Ask When Opening, Ask When Pasting, and
Missing Profiles: Ask When Opening.

This option displays an alert message that allows you to override
the specified policy behavior (Off) when opening documents or
importing color data.
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This is recommended so that you will be notified before any
application color management is applied.
6. In the Conversion Options area, specify settings for converting
between color spaces.

Choose Adobe (ACE) from the Engine menu to use the built-in
color management engine for Photoshop.
Choose a rendering intent from the Intent menu that will optimize
the color quality of the conversion. For guidelines on choosing the
rendering intent, see your Photoshop documentation.
Select Use Black Point Compensation and Use Dither (8-bit/
channel images) to optimize the quality of color conversions.
7. Clear the Desaturate Monitor Colors By and Blend RGB Colors
Using Gamma options in the Advanced Controls area.

Clearing these options helps ensure a match between your
monitor display and the printed output.
8. Click Save to save the current group of color settings.

The Save dialog box appears.
9. Name the settings file, accept the default saved location, and click
Save.

You can switch to your saved settings at any time by choosing the
group name from the Settings menu at the top of the Color
Settings dialog box.
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Saving files from Photoshop
Before saving a file from Photoshop, perform any necessary
rotating, cropping, and resizing. This speeds processing when
printing from the application in which the image is placed.
When saving a document from Photoshop 6.x, you have the
option to embed a color profile in the document. We recommend
that you disable this option if you are sending the document to
the Fiery.

Choosing a file format
We recommend that you use EPS or TIFF file formats to save RGB
images that will be imported into other documents and printed to
the Fiery. You can import EPS and TIFF files into virtually all page
layout applications.
Note: Although TIFF files generally display better when imported

into other applications, their color and resolution characteristics
may be altered by the application into which they are imported.
EPS files are not modified by the application into which they are
imported.
Note: In the following procedures, only Photoshop 7.x (Mac OS

version) dialog boxes are shown. When applicable, differences
between versions 7.x and 6.x, and the Windows and Mac OS
versions of Photoshop are noted.
To save a document from Photoshop
1. Choose Save As from the File menu.

The Save As dialog box appears.

Sharp AR-C360P EFI Color Reference Guide - 46

5

5-47 Saving files from Photoshop

2. Specify settings in the Save As dialog box.

• Specify a name, file format, and location for the document.
• Clear the Embed Color Profile option (Mac OS) or ICC Profile
option (Windows).
3. Click Save.

If you chose Photoshop EPS as the format, the EPS Options dialog
box appears.

Sharp AR-C360P EFI Color Reference Guide - 47

5

5-48 Managing Color in Adobe Photoshop

4. Specify EPS options and click OK.

• Choose a TIFF preview option. A TIFF preview is compatible with
both Windows and Mac OS computers.
• Do not select the PostScript Color Management option. For more
information about PostScript Color Management, see the
following section.
• Do not select Include Transfer Function or Include Halftone
Screen.
Note: If you choose JPEG encoding, save a backup of the original

image saved with binary encoding until you see the printed results
of the JPEG file. Occasionally, the compression used for JPEG
encoding produces unwanted artifacts. If you see unexpected
results in the printed output of a JPEG file, revert to a binary
version.
If you experience problems printing the document in which you
placed the image, substitute an ASCII version of the same image
and reprint the document. Binary encoding is much more compact
than ASCII encoding, but occasionally causes printing problems
with some system configurations.
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Selecting options when printing
You can print RGB or CMYK images from Photoshop.
• When you print an RGB image, you choose whether the
conversion to CMYK is performed by the Fiery (using a CRD),
PostScript (using PostScript Color Management), or Photoshop
built-in color management.
• When you print a CMYK graphic, you can print composites or
color separations.
Note: Make sure that the Fiery Combine Separations print option

is set to Off. To print separations, use the Separation option in the
Adobe Photoshop pane of the print dialog box. For instructions,
see your Photoshop documentation.
To print images from Photoshop 7.x
1. Choose Print with Preview from the File menu.

The Print dialog box appears.
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Photoshop 7.x

2. Select Show More Options.
3. Select Output.
4. Choose an Encoding method.
Note: If you choose JPEG encoding, save a backup of the original

image with binary encoding until you see the printed results of the
JPEG file. Occasionally, the compression used for JPEG encoding
produces unwanted artifacts. If you see unexpected results in the
printed output of a JPEG file, revert to the binary version.
5. Select Color Management.
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Photoshop 7.x

6. Choose Same as Source from the Profile menu to specify the color
space for printing the image.

Any other setting causes Photoshop to convert image data to that
color space before sending it to the Fiery.
7. Click Print.

To print images from Photoshop 6.x
1. Choose Print from the File menu.

The Print dialog box appears.
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Photoshop 6.x

2. Choose the Fiery from the Printer menu, and then choose Adobe
Photoshop from the pop-up menu.
3. Choose an Encoding method.
Note: If you choose JPEG encoding, save a backup of the original

image with binary encoding until you see the printed results of the
JPEG file. Occasionally, the compression used for JPEG encoding
produces unwanted artifacts. If you see unexpected results in the
printed output of a JPEG file, revert to the binary version.
4. Choose Same as Source from the Profile menu to specify the color
space for printing the image.

Any other setting causes Photoshop to convert image data to that
color space before sending it to the Fiery.
5. Click Print.

Advanced tips for using PostScript color
management
Use the following information to implement alternative, more
complex, color workflows with Photoshop.
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Note: To use PostScript color management with Photoshop 6.x,
choose PostScript Color Management from the Profile menu in the
Photoshop pane of the printer driver.

Saving EPS documents with PostScript Color Management
Selecting the PostScript Color Management option when saving
either a CMYK or RGB EPS file prompts Photoshop to embed
PostScript color information—which is independent of ICC
profiles—in the resulting document. This information is intended
for PostScript devices like the Fiery.
Printing RGB EPS files saved with PostScript Color
Management
When you print an RGB EPS file that contains an embedded profile
to the Fiery, you can use the working space information from the
embedded RGB profile as an RGB source definition for Fiery CRDs.
To use this source color space information from the embedded
profile with Fiery CRDs, choose None as the ColorWise RGB
Source when you print. This applies when you print directly from
Photoshop, or when the same RGB EPS file is output from another
application.
To override the embedded profile in an EPS file using an RGB
Source definition made available by the Fiery, choose anything
except None as the Fiery RGB Source Profile.
Printing RGB images with Photoshop PostScript Color
Management
If you select an RGB color space and decide to use PostScript
Color Management, Photoshop sends RGB data to the Fiery along
with PostScript color information defining this RGB color space.
When you select PostScript Color Management, a CRD is used to
perform color conversions to CMYK.
Note: The included RGB source color space information is

overridden by the ColorWise RGB Source option unless it is set to
None. The ColorWise Rendering Style option specified will take
effect if the ColorWise RGB Source Profile option is set to None.
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For fastest print times, choose JPEG encoding, but inspect printed
output carefully for unwanted artifacts that may appear as a
result of JPEG compression. If you see unexpected results in the
printed output, reprint the job using Binary or ASCII encoding.
Printing CMYK EPS files saved with PostScript Color
Management
If you select the Photoshop PostScript Color Management option
when you save a CMYK EPS image, Photoshop embeds PostScript
color information that defines the CMYK source color space of the
image. When you print a CMYK EPS file that contains PostScript
color information to the Fiery, CRDs are used instead of ColorWise
CMYK Simulation and Simulation Method settings. Choose the
appropriate setting for the Rendering Style option.
Printing CMYK graphics with Photoshop PostScript Color
Management
If you select a CMYK color space and decide to use PostScript
Color Management, Photoshop sends CMYK data to the Fiery
along with PostScript color information defining this CMYK color
space. When you select PostScript Color Management, a CRD is
used to perform color conversions to the CMYK color space of the
Fiery.
The destination color space for the CRDs is determined by the
RGB Separation print option. If RGB Separation is set to
Simulation, the CMYK graphic is printed according to all specified
CMYK Simulation Profile and CMYK Simulation Method settings.
If RGB Separation is set to Output, the CMYK graphic is converted
to the CMYK color space of the selected output profile.
Setting the Fiery print option Spot Color Matching to On has an
effect only if you use the Photoshop Multi-Channel feature to
define spot channels and then save the image in EPS format and
open it in another application. For information see your Photoshop
documentation.
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Photoshop converts spot colors to CMYK values when you work in
CMYK mode.
• If the graphic was separated for an offset press standard, apply
the corresponding CMYK Simulation setting. For example, if the
graphic is separated for SWOP, choose SWOP as the CMYK
Simulation setting.
• If Photoshop is configured for a custom separation using a ICC
profile, choose the corresponding profile for the ColorWise CMYK
Simulation option.
The previous custom simulation setting requires that the same
profile used for separation in Photoshop also resides on the Fiery.
For more information about downloading CMYK Simulation profiles
to the Fiery with ColorWise Pro Tools, see the Color Guide
Chapter 3.
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Chapter 6:
Managing
Color in
Page Layout
Applications

This chapter provides instructions for printing color documents
from Adobe InDesign, Adobe PageMaker, and QuarkXPress.
Before printing from these applications, make sure the
appropriate printer driver and the Fiery PostScript printer
description file (PPD) are installed on your computer, as described
in the User Software Installation Guide.

Adobe InDesign 2.0.1 and 1.5.2
The following sections outline the recommended settings for using
Adobe InDesign with a Fiery.

InDesign color settings
When using ColorWise color management, turn off the InDesign
color management features.
To disable InDesign 2.0.1 color management
1. Choose Color Settings > Document Color Settings from the Edit
menu.
2. Clear the Enable Color Management option and click OK.
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To disable InDesign 1.52 color management
1. Choose Color Settings > Document Color Settings from the Edit
menu.
2. Clear the Enable Color Management option and click OK.
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Importing images
All RGB images placed in a document, except for RGB TIFF
images, are affected by your RGB Source and Rendering Style
settings. For best results with placed images, use the instructions
in “Working with imported images” on page 4-39.
Note: InDesign converts placed RGB TIFF images to CMYK.

Disable InDesign color management when placing images in a
document.
To disable InDesign 2.0.1 color management
when importing images
1. Choose Place from the File menu.

The Place dialog box appears.
2. Select the Show Import Options option.
3. Select the file you want to import and click Open.
4. Choose Color Settings from the option menu. Make sure the
Enable Color Management option is cleared, and click OK.

To disable InDesign 1.5.2 color management
when importing images
1. Choose Place from the File menu.

The Place dialog box appears.
2. Select the Show Import Options option.
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3. Select the file you want to import and click Place.
4. Choose Color Settings from the option menu. Make sure the
Enable Color Management option is cleared, and click OK.

Selecting options when printing
You can use the standard Fiery printer driver interface to select
print options from InDesign.
To set print options from the Windows version of
InDesign 2.0.1
1. Choose Print from the File menu.
2. Choose the Fiery from the Printer menu.
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3. Click Setup.

The Windows Print dialog box appears.
4. Click Properties.
5. Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Fiery appears.
6. Choose the desired print options.

For information on setting ColorWise print options, see the Color
Guide Chapter 1.
7. Click Print.

To set print options from the Mac OS version of
InDesign 2.0.1
1. Choose Print from the File menu.
2. Choose the Fiery from the Printer menu.
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3. Click Printer.

The AdobePS Print dialog box appears.

4. Choose Printer Specific Options.

The Fiery print options appear.
5. Select the desired options.
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For information on setting ColorWise print options, see the Color
Guide Chapter 1.
6. Click Print.

To set print options from the Windows version of
InDesign 1.5.2
1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Fiery from the Name menu.
3. Click Properties.
4. Click the Fiery Printing tab in the dialog box that appears.

The standard printer driver interface for the Fiery appears.
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5. Choose the desired print options.

For information on setting ColorWise print options, see the Color
Guide Chapter 1.
To set print options from the Mac OS version of
InDesign 1.5.2
1. Choose Print from the File menu.

The Print dialog box appears.

2. Choose the Fiery from the Printer menu.
3. Choose Printer Specific Options.

The Fiery print options appear.
4. Select the desired options.

For information on setting ColorWise print options, see the Color
Guide Chapter 1.
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Adobe PageMaker 7.x and 6.5 for Mac OS
and Windows
The Mac OS and Windows versions of PageMaker 7.x and 6.5 are
essentially the same. The illustrations in this section show only
the Windows version, except where differences exist between the
two versions.

Windows version requirement
To use the Windows version of PageMaker 6.5, make sure a copy
of the Fiery PPD file is in the following folders:
• PM65\RSRC\USENGLSH\PPD4
• Windows\System
For information about installing this file, see your PageMaker
documentation.

PageMaker color settings
We recommend that you use ColorWise color management rather
than the CMS options built into Adobe PageMaker.
Note: Do not use both systems for the same print job.

To disable PageMaker color management
1. Choose Preferences > General from the File menu.
2. Click CMS Setup.
3. Choose Off from the Color Management menu.
4. Click OK, and then click OK again to close the dialog boxes.
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To disable color management for a bitmapped
image
1. Select the bitmapped image in the document.
2. Choose Image > CMS Source from the Element menu.
3. Choose None from the This Item Uses menu and click OK.

Importing images
All RGB images placed in a document are affected by your RGB
Source and Rendering Style settings. For best results with placed
images, use the instructions in “Working with imported images”
on page 4-39.

Selecting options when printing
All print settings are specified from the various Print dialog boxes
in PageMaker 7.x or 6.5.
Note: The Print dialog box for PageMaker is different than the Print

dialog box for other applications that print to the Fiery. Follow the
instructions in this section rather than the print instructions in the
Color Guide.
To set print options when printing from
PageMaker
1. Choose the Fiery printer description from the PPD menu in the
Print Document dialog box.
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Choose the Fiery PPD

Click Options

2. Click Options.
3. Choose Normal from the “Send image data” menu in the Print
Options dialog box and click Features.

To ensure that TIFF images print at their full resolution, do not
choose the Optimized Subsampling default from the “Send image
data” menu.
4. If a document contains RGB placed images or colors defined in
RGB that will not be separated to process colors, choose RGB
Source and Rendering Style settings in the Print Features dialog
box.
If the document contains PANTONE colors, choose the
appropriate Spot Color Matching setting.

Sharp AR-C360P EFI Color Reference Guide - 66

6

6-67 QuarkXPress 5.x and 4.x for Mac OS

5. Click Print from any of the PageMaker dialog boxes to send the
job to the Fiery.

Using optional Color Management from
PageMaker
If you have additional color management requirements not
offered by ColorWise, such as managing color on devices not
controlled by the Fiery, consider using the PageMaker color
management features. For more information, see your PageMaker
documentation.

QuarkXPress 5.x and 4.x for Mac OS
Importing images
With the exception of RGB images that are saved in EPS format or
use Quark PrintRGB XTension, QuarkXPress converts all RGB data
into CMYK, even when Quark CMS XTension is disabled.
Only RGB images saved in EPS format are affected by RGB Source
and Rendering Style settings. For best results with placed images,
follow the instructions in “Working with imported images” on
page 4-39.
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Selecting options when printing
The following procedure provides instructions on printing files to
the Fiery.
To set print options in QuarkXPress 5.x or 4.x
1. Choose the Fiery printer description name from the Printer
Description menu in the Print dialog box.

Choose the Fiery
Choose an output
paper size

Click to specify printer
settings
Mac OS

2. If the document contains PANTONE colors, choose the
appropriate Spot Color Matching setting.

For instructions on specifying print options, see the Color Guide
Chapter 1.

Optional Color Management from QuarkXPress
If you have additional color management requirements not
offered by ColorWise, such as managing color on devices not
controlled by the Fiery, you may want to consider using
the QuarkXPress color management features. For more
information, see your QuarkXPress documentation.
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For QuarkXPress 4.02, consider using Quark CMS XTension.
These features allow advanced users to control RGB to CMYK color
conversions. If you plan to use these features, make sure that
Quark CMS XTension is installed before starting QuarkXPress. If it
is not installed, use the Quark XTensions Manager to install it.
For instructions, see your QuarkXPress documentation.
Note: Quark CMS converts RGB TIFF, JPEG, and PICT images to

CMYK before sending color data to the Fiery. RGB Source and
Rendering Style settings have no effect on this data unless you
use Quark PrintRGB XTension, which outputs RGB TIFF image files
without converting them to CMYK.
QuarkXPress 3.32 for Mac OS and Windows
Before starting QuarkXPress 3.32, make sure the EfiColor
XTension is not loaded in the XTensions folder. EFICOLOR profiles
are not currently provided with Fiery products. Without the correct
EFICOLOR profile, the EfiColor XTension cannot perform color
conversions on placed images.

Windows version requirement
For the Windows version of QuarkXPress, make sure a copy of the
Fiery PPD file is in the \XPRESS\PDF folder.

Importing images
All RGB images placed in a document are affected by your RGB
Source and Rendering Style settings. For best results with placed
images, follow the instructions in “Working with imported images”
on page 4-39.

Selecting options when printing
The following procedure provides instructions on printing files to
the Fiery.
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To select print options in QuarkXPress 3.3
1. Choose the Fiery printer description from the Printer Type menu
in the Page Setup (Mac OS) or Printer Setup (Windows) dialog
box.

Choose the Fiery

Choose an output paper
size
Choose Binary

Mac OS

Choose output
paper size

Choose the Fiery

Choose Binary

Windows

2. If a document contains RGB-placed images or RGB colors that
QuarkXPress will print without converting to CMYK, choose RGB
Source and Rendering Style settings.
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If the document contains PANTONE colors, choose the
appropriate Spot Color Matching setting.

For instructions on specifying print options, see the Color Guide
Chapter 1.
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Chapter 7:
Managing
Color in
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Applications

You can print directly from an illustration application or use it to
create and save files that will be imported into a page layout
document. To print from an illustration application, use the printer
driver and print settings recommended in the Color Guide
Chapter 1. As a general rule, use the EPS file format when saving
files with an illustration application. When an EPS file is imported
into another application, the color information in the imported
image will not be changed by the application into which it is
imported.
Before printing from illustration applications, make sure the
appropriate PostScript printer driver and the Fiery PPD are
installed on your computer, as described in the User Software
Installation Guide. This chapter provides instructions for using
Adobe Illustrator, Macromedia FreeHand, and CorelDRAW for
Windows and Mac OS.
Note: This manual provides instructions for printing composites

only.
For instructions on printing color separations, see the
documentation for your application.

Adobe Illustrator for Windows and Mac OS
The following sections provide guidelines for working with Adobe
Illustrator versions 10.x and 9.x.

Note about color models in Adobe Illustrator
In Illustrator, you can set the Document Color Mode to either RGB
Color or CMYK color. All elements in that file are created in that
color model. When you print the file, the data is sent to the Fiery
in the color model that you specified.

Illustrator color settings
Illustrator uses a sophisticated color management system that
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can handle both RGB and CMYK colors for a variety of colormanaged workflows. By customizing color settings, you specify
the amount of color management you want to use while working
in Illustrator. These color settings include:
Working spaces—Default color spaces to use when working with
RGB and CMYK documents. ICC color profiles describe the gamut
and color characteristics of these working spaces.
Color management policies—Instructions that tell Illustrator what

to do when it encounters color data from a color space other than
the specified working space.

Specifying print options
The following procedure outlines the recommended color settings
for Illustrator in a Fiery workflow.
To specify color settings
1. Choose Color Settings from the Edit menu.

The Color Settings dialog box appears.
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2. Select Advanced Mode.

In Advanced Mode, a more extensive list of options is displayed.
3. Choose the desired working space profile for each mode in the
Working Spaces area.

Use the following guidelines for specifying working spaces:
• For RGB, choose EFIRGB. This profile represents the default RGB
color space used by the Fiery. New RGB documents you create
in Illustrator will use this working space.
• For CMYK, choose a profile that describes your target press
(such as SWOP) if you are a prepress user. If you are an office
user printing final output, choose an output profile that
describes the Sharp AR-C360P. To use a device-specific output
profile, upload the profile from the Fiery to your computer (see
the Color Guide Chapter 3). New CMYK documents you create in
Illustrator will use the specified working space.
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4. Choose policies for handling documents without embedded
profiles or with embedded profiles that differ from the working
space in the Color Management Policies area.

Choose Off from the RGB and CMYK menus. This option discards
the original profile embedded in a document if it differs from the
specified working space.
In the Profile Mismatches area, select the Ask When Opening
option. This option displays an alert message that allows you to
override the specified policy behavior (Off) when opening
documents or importing color data.
5. Choose settings for converting between color spaces in the
Conversion Options area.

Choose Adobe (ACE) from the Engine menu to use the built-in
color management engine for Illustrator.
Choose a rendering intent from the Intent menu that will optimize
the color quality of the conversion. For guidelines on choosing the
rendering intent, see your Illustrator documentation.
Select the Use Black Point Compensation option to optimize the
quality of color conversions.
6. Click Save to save the current group of color settings.

The Save dialog box appears.
7. Name the settings file, accept the default saved location, and click
Save.

You can switch to your saved settings at any time by choosing the
group name from the Settings menu at the top of the Color
Settings dialog box.

Saving files for importing into other documents
When saving files in Illustrator for importing into other types of
documents, use the EPS file format. Illustrator can save color
information in both RGB and CMYK. The ColorWise RGB Source
and Rendering Style settings affect color output of RGB artwork
saved in Illustrator EPS and imported into other kinds of
documents (even when both RGB and CMYK artwork exists in the
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same file). In the case of Illustrator files imported into Photoshop,
however, vector data from the Illustrator file is rasterized into
bitmaps in Photoshop, and the final color space of the bitmap data
is determined by the color mode you set in Photoshop.

Specifying print options
The following procedure explains how to set print options when
printing a document from Illustrator to the Fiery.
To set print options in Illustrator
1. Choose Print from the File menu in Illustrator.

The Print dialog box appears.
2. For the Windows version of Illustrator, specify appropriate print
options.

• Choose the Fiery device from the Name menu.
• Choose Composite from the Output menu.
• Choose Level 3 from the PostScript menu. If you encounter
problems, you can also use Level 2.
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Click Properties
to set print
options

Select the device name

Choose Composite

Illustrator 10.x for Windows

Sharp AR-C360P EFI Color Reference Guide - 77

7

7-78 Managing Color in Illustration Applications

Click Properties
to set print
options

Select the device name

Choose Composite
Choose PostScript Level
2 or 3

Illustrator 8.x and 9.x for

3. For the Mac OS version of Illustrator, specify appropriate print
options.

• Choose the Fiery device from the Printer menu.
• Choose Adobe Illustrator from the option menu below the
Printer menu.
• Choose Composite from the Output menu.
• Choose Level 3 from the PostScript menu. If you encounter
problems, you
can also use Level 2.
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Choose Composite

Illustrator 10.x for Mac OS

Choose Composite
Choose PostScript
Level 3

Illustrator 8.x and 9.x for Mac OS
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4. If necessary, click Properties (Windows) or choose Printer
Specific Options from the option menu (Mac OS) and choose RGB
Source and Rendering Style settings for the Fiery.

You only need to specify these settings if you have a CMYK
document containing placed RGB images, or an RGB document in
Illustrator 9.x. In all other cases, colors remain unaffected by the
settings.
5. If the document contains PANTONE-named colors, choose the
appropriate Spot Color Matching setting.

For instructions on setting additional ColorWise print options, see
the Color Guide Chapter 1.

Using Illustrator color management
If you have additional color management requirements not
offered by ColorWise, such as managing color on devices not
controlled by the Fiery, you may want to consider using the
Illustrator color management features. For more information, see
your Illustrator documentation.

FreeHand 10.x, 9.x, and 8.x for Windows and
Mac OS
The information in this section applies to both the Windows and
Mac OS versions of FreeHand. Only Mac OS dialog boxes are
shown, but the information and instructions are identical for the
Windows version.

Setting FreeHand color settings
When using ColorWise color management, turn off the FreeHand
color management features.
To disable color management in FreeHand
1. Choose Preferences from the File menu.
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2. Click the Colors category in the Preferences dialog box.

Click Colors to access
the color management
settings

3. Choose None for the type of color management.

Defining colors
Any colors defined in FreeHand are sent to the device in CMYK—
even those defined using other color models. For best results, use
the color definition methods described on page 4-34.
You can control the conversion of RGB colors defined in FreeHand
by specifying settings in the Preferences dialog box under the
Colors category, or choosing Color Management from the
FreeHand menu on the Print dialog box.
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Importing images
A number of file types can be imported into FreeHand, but once
imported, all are treated as EPS images, TIFF images, or editable
paths. For details, see your FreeHand documentation.
When you import an EPS image into a document, FreeHand
inserts a link to the image rather than embedding the original file,
resulting in a smaller file size. If the image is a CMYK EPS file, the
colors print just as they would from the originating application.
Note: Before placing a CMYK EPS file, be sure the file was saved

with Desktop Color Separation (DCS) set to Off. If the file was
saved with DCS activated, FreeHand prints composites of the
image at the low resolution used for screen viewing.
All RGB images placed in a document are affected by your RGB
Source and Rendering Style settings in the PPD. For best results
with placed images, follow the instructions in “Working with
imported images” on page 4-39.

Saving files for importing into other documents
When saving files in FreeHand for importing into other types of
documents, use the EPS file format. FreeHand saves all color
information in CMYK. The RGB Source and Rendering Style print
options have no effect on the color output of RGB artwork saved in
FreeHand and imported into other types of documents. In the
case of FreeHand files imported into Photoshop, however, vector
data from the FreeHand file is rasterized into bitmaps in
Photoshop, and the final color space of the bitmap data is
determined by the color mode you set in Photoshop.
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Selecting options when printing
To set options when printing from FreeHand
1. Select the Use PPD option in the Print dialog box.

Click to access
FreeHand Print
Setup

Choose Normal
Click to select a printer
description
(Name appears at right)

2. Choose Normal from the Print setting menu.

• If the Use PPD option is selected, a plus sign (+) appears in
front of the word “Normal.”
• If the model name for your Fiery is not displayed, click the
button
labeled “…” and choose the appropriate Fiery model from the
menu that appears.
3. To use ColorWise color management features, choose Output
Options from the File menu.
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The Output Options dialog box appears.

Clear option to use
ColorWise
color management

4. Make sure the “Convert RGB to process” option is cleared.

If this option is selected, FreeHand color management settings are
used to convert RGB colors and RGB TIFF, PICT, and JPEG images
to CMYK.
5. If a document contains placed RGB images, choose RGB Source
and Rendering Style settings.

With the exception of placed RGB images, these settings have no
effect on colors printed with FreeHand. If the document contains
PANTONE-named colors, choose the appropriate Spot Color
Matching setting when you print the document.
For information about other FreeHand print options, see your
FreeHand documentation.

Optional color management in FreeHand
If you have additional color management requirements not
offered by ColorWise, such as managing color on devices not
controlled by the Fiery, you may want to consider using the
FreeHand color management features. For more information, see
your FreeHand documentation.
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CorelDRAW for Windows and Mac OS
The following sections describe the recommended color settings
for CorelDRAW
9.x and 8.x.

Defining colors
Any colors defined in CorelDRAW 9.x for Windows or CorelDRAW
8.x for Mac OS are sent to the device in CMYK—even those
defined using other color models. For best results, use the color
definition methods described in “Using color matching tools with
PostScript applications” on page 4-34.
You can control the conversion of RGB colors defined in
CorelDRAW by specifying settings in the Color Management dialog
boxes. On Windows computers, the Color Management dialog
boxes are located in Tools > Color Management. On Mac OS
computers, the Color Management functions are located in
Edit : Preferences : Global.
Note: If you do not want to use color management in CorelDRAW,

choose None from the composite printer menu under Color
Management/Profiles. Do not select options under Color
Management and Color Management General.

Importing images
All RGB images placed in a document are affected by the RGB
Source and Rendering Style settings. For best results with placed
images, follow the instructions in “Working with imported images”
on page 4-39.

Saving files for importing into other documents
When saving files in CorelDRAW for importing into other types of
documents, use the EPS file format. CorelDRAW saves all color
information in CMYK, so RGB Source and Rendering Style print
options have no effect on color output of artwork saved with
CorelDRAW and imported into other kinds of documents. In the
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case of CorelDRAW files imported into Photoshop, however, vector
data from the CorelDRAW file is rasterized into bitmaps in
Photoshop, and the final color space of the bitmap data is
determined by the color mode you set in Photoshop.

Specifying print options
The following procedure outlines how to set print options when
printing from CorelDRAW to the Fiery.
To set print options in CorelDRAW
1. On Windows computers, click the General tab, and then click
Print.
2. Make sure you have selected the correct device and printer
description, and select the
Use PPD option.
3. Click Properties to specify ColorWise print options.

Print device name
appears here

Click Properties to access
ColorWise print options

Printer driver/PPD
name appears here

4. On Mac OS computers, click Printer in the General Print dialog box
to select the device and print options.
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To use ColorWise color management, make sure the “Use color
profile” option on the Misc tab of the Print dialog box is cleared. If
this option is selected, CorelDRAW color management settings are
used to convert RGB colors and images to CMYK.

Clear this option to use
ColorWise Color
Management

5. If a document contains placed RGB images, choose RGB Source
and Rendering Style settings for your device.

With the exception of placed RGB images, these settings have no
effect on colors printed with CorelDRAW.
6. If the document contains PANTONE-named colors, choose the
appropriate Spot Color Matching setting.

Optional color management in CorelDRAW
If you have additional color management requirements not
offered by ColorWise, such as managing color on devices not
controlled by the Fiery, consider using the CorelDRAW color
management features. For more information, see your
CorelDRAW documentation.
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Desktop
Color Primer

The properties of color

This appendix covers concepts that are basic to printing in color,
including:
• Properties of color
• Printing techniques
• Effective use of color
• Raster images and vector graphics
• File optimization for processing and printing
If you are already familiar with color theory and digital color
printing, you can skip to the last section (“Optimizing files for
processing and printing” on page A-105) for tips on optimizing
files for printing.

The properties of color
This section introduces concepts that are basic to color theory.
You will encounter some of these concepts (such as hue,
saturation, and brightness) when you work with color in
applications; others provide useful background information. Color
is a complex topic, so consider this a starting point for
experimentation and further research.

The physics of color
The human eye can see electromagnetic radiation at wavelengths
between 400 nanometers (purplish blue) and 700 nanometers
(red). This range is called the visible spectrum of light. We see
pure spectral light as intensely saturated or pure colors. Sunlight
at midday, which we perceive as white or neutral light, is
composed of light from across the visible spectrum in more or less
equal proportions. Shining sunlight through a prism separates it
into its spectral components, resulting in the familiar rainbow of
colors shown in the following figure.
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Like the sun, most light sources we encounter in our daily
environment emit a mixture of light wavelengths, although the
particular distribution of wavelengths can vary considerably. Light
from a tungsten light bulb, for example, contains much less blue
light than sunlight. Tungsten light appears white to the human
eye, which, up to a point, can adjust to the different light sources.
However, color objects appear different under tungsten light than
they do in sunlight because of the different spectral makeup of the
two light sources.
The mixture of light wavelengths emitted by a light source is
reflected selectively by different objects. Different mixtures of
reflected light appear as different colors. Some of these mixtures
appear as relatively saturated colors, but most appear as grays or
impure hues of a color.
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CIE color model
In the 1930s, the Commission Internationale de l’Eclairage (CIE)
defined a standard color space, a way of defining colors in
mathematical terms, to help in the communication of color
information. This color space is based on research on the nature
of color perception. The following CIE chromaticity diagram is a
two-dimensional model of color vision. The arc around the top of
the horseshoe encompasses the pure, or spectral, colors from
blue-violet to red. Although the CIE chromaticity diagram is not
perceptually uniform—some areas of the diagram seem
to compress color differences relative to others—it is a good tool
for illustrating some interesting aspects of color vision.

By mixing any two spectral colors in different proportions, we can
create all the colors found on the straight line drawn between
them in the diagram. It is possible to create the same gray by
mixing blue-green and red light or by mixing yellow-green and
blue-violet light. This is possible because of a phenomenon
peculiar to color vision called metamerism. The eye does not
distinguish individual wavelengths of light. Therefore, different
combinations of spectral light can produce the same perceived
color.
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Purple colors, which do not exist in the spectrum of pure light, are
found at the bottom of the diagram. Purples are mixtures of red
and blue light—the opposite ends of the spectrum.

Hue, saturation, and brightness
A color can be described in terms of three varying characteristics,
called the HSB color model:
• Hue—tint (the qualitative aspect of a color—red, green, or
orange)
• Saturation—the purity of the color
• Brightness—relative position between white and black
While the CIE chromaticity diagram shown earlier conveys hue
and saturation, a three-dimensional color model is required to add
the brightness component, as shown in the following figure.

Brightness

Hue
Saturation
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Many computer
applications include
dialog boxes in which
you choose colors by
manipulating hue,
saturation, and
brightness. For
example, some
applications use a
color picker that can
be reconfigured
according to your
preference (as shown
below).

Additive and subtractive color systems
Color devices used in desktop publishing and printing simulate the
range of visible colors using a set of primary colors that are
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combined to create other colors. There are two methods for
creating a range of colors from a set of primary colors. Computer
monitors and scanners are based on the additive color model.
Printing technologies, including the Fiery and offset presses, are
based on the subtractive color model.
Additive (RGB) color
Color devices that use the additive color model create a range of
colors by combining varying amounts of red, green, and blue
light. These colors are called the additive primaries (shown in the
following figure). White is created by adding the maximum
amount of red, green, and blue light available. Black occurs
wherever all three colors are absent. Grays are created by adding
equal amounts of all three color together. Combining varying
amounts of any two of the additive primaries creates a third,
saturated hue.

A familiar device that is based on this color model is the computer
monitor, shown in the following figure. Monitors have red, green,
and blue phosphors that emit varying amounts of light to display a
given color. Scanners create digital representations of colors by
measuring their red, green, and blue components through colored
filters.
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Subtractive (CMY and CMYK) color
The subtractive color model is the basis for color printing, color
photographic prints, and transparencies. While the additive color
model simulates the visible spectrum of color by adding light of
three primary hues, the subtractive color model starts with a
“white” or neutral light source containing light of many
wavelengths. Inks, toners, or other colorants are used to
selectively absorb (subtract) certain wavelengths of light that
otherwise would be reflected or transmitted by the media in use.
The subtractive primariesare cyan, magenta, and yellow; they
absorb red, green, and blue light, respectively (as shown in the
following figure). Combining any two subtractive primaries creates
a new color that is relatively pure or saturated. For example, you
can make red by combining magenta and yellow, which absorb
green and blue light, respectively. White occurs when no colorant
is applied. In theory, combining all three subtractive primaries
yields black, but due to deficiencies of cyan, magenta, and yellow
colorants, combining these three primaries actually yields a
muddy brown. Black colorant is added to compensate for the
deficiencies of cyan, magenta, and yellow colorants.
Consequently, color printing uses four process color: Cyan,
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Magenta, Yellow, and blacK (CMYK). The use of black toner
produces rich, solid blacks and allows for improved rendering of
black text.
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Understanding color gamut
Different color reproduction techniques have different color
capabilities, or gamuts. Color transparency films have
comparatively large gamuts, as do color monitors. The color
gamut that can be produced using process inks or CMYK toners on
paper is smaller. This is why some colors that can be displayed on
a color monitor, especially bright saturated colors, cannot be
reproduced exactly by your Fiery—nor, for that matter, can they
be reproduced on a press using process colors. Moreover, different
printers have different gamuts—some colors your printer can
produce cannot be reproduced on an offset press, and vice versa.
The following figure illustrates this concept of differing gamuts.

Color transparency film
RGB monitor

Offset press (white)

Other print device

You must account for the gamut of your printer when designing on
a color monitor. When printed, colors that fall outside the printer
gamut are “mapped” to printable colors. This process, referred to
as gamut mapping, takes place when color data is converted or
adjusted to meet the gamut requirements of a printer.
The Fiery is specially designed to perform gamut mapping at high
speed with high-quality results. It provides these color
management features automatically, using either built-in default
settings or settings you select for a particular print job. For added
flexibility, you can also use the Fiery color management system in
combination with the color management systems on Windows and
Mac OS computers.
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Printing techniques
Until recently, most color printing was done on printing presses
using one of several printing techniques—offset lithography,
flexography, or gravure, to name a few. All traditional printing
techniques require lengthy preparation before a press run can
take place. Short-run color printing, including Fiery printing,
eliminates most of this preparation. By streamlining the process of
color printing, the Fiery makes short print runs economically
feasible.
In contemporary offset lithographic printing, digital files from
desktop computers are output to an imagesetter, which creates
film separations. The film is used to make a prepress proof, which
is an accurate predictor of the final print job and allows you to
make corrections before going to press. Once the proof is
approved, the printer makes plates from the film and runs the
print job on the press.
With the Fiery, you simply print the file. The Fiery processes the
PostScript information in the file and sends four bitmaps (one
each for cyan, magenta, yellow, and black) to the printer. The
ease of Fiery printing makes possible experimentation that would
be too costly on a press, allowing unlimited fine-tuning of color
and design elements.

Halftone and continuous tone devices
Halftoning is used in offset printing to print each process color at a
different intensity, allowing millions of different colors to be
reproduced using only the four process colors. Depending on the
required intensity of a given color, toner is placed on paper in dots
of different size. The grid of dots used for each toner color is
called a screen. Halftone screens are aligned to unique angles
designed to eliminate interference patterns called moiré that can
arise with halftoning.
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Some color printers are commonly referred to as continuous tone
(contone) devices. They do not use traditional halftone screen
patterns and angles. Contone devices are capable of varying the
intensity of individual dots.
Even if your color printing is done exclusively on the Fiery, you will
encounter concepts from offset printing if you use high-end
graphics applications. For example, color controls in illustration
applications, such as Adobe Illustrator, are geared toward
specifying color for offset printing using process and spot colors.
Many applications allow you to specify the screening used for each
printing plate.

Using color effectively
The ability to print in color can greatly increase the effectiveness
of your message, whether you are printing a presentation or
newsletter (short-run printing), or proofing an ad concept that will
later be printed on a press (color proofing). Some potential
benefits of using color include:
• Conveying information rapidly by using color cues
• Making use of the emotive aspects of different colors
• Increasing impact and message retention
Color can also be a source of distraction and discord if it is used
poorly. This section outlines some tips and concepts to consider as
you approach designing color materials.

A few rules of thumb
Try some of the following strategies for creating successful color
materials:
• Use color to aid comprehension, rather than applying colors
indiscriminately. In color presentations, graphs, and charts, use
color to highlight patterns and emphasize differences.
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• Use color sparingly. In general, fewer colors work better than
many colors.
• Use red as an accent color. Red is particularly effective when
used in otherwise monochromatic materials.
• Consider the tastes of your target audience when choosing
colors.
• Keep a file of printed color pieces that appeal to you or strike
you as effective. Refer to it for ideas when designing your own
documents.

Color wheel
A color wheel like the one in the following figure is a helpful tool
for understanding the interrelation of colors. The colors on one
side of the color wheel, from magenta to yellow, appear to most
people to be warm colors, while those on the other side, from
green to blue, appear to be cool. The distance between two colors
on the color wheel can help predict how they will appear when
seen side by side.
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Colors opposite one another on the color wheel are called
complements (see example a in the following figure), and create a
striking contrast side by side. This can be the basis for a bold
graphical design, but it is an effect you should use with discretion,
since it can be visually fatiguing. Other bold combinations to
consider are split complements—a color and the two colors
adjacent to its complement (example b)—and triads (three colors
evenly spaced on the color wheel (example c). Colors adjacent to
one another on the color wheel result in subtle harmonies.

a

b

c

The color wheel simplifies color relationships for the purpose of
clarity, showing only saturated or pure colors. Adding the myriad
variations of each hue to the palette (more or less saturated,
darker, or lighter) creates a wealth of possibilities. Taking a pair of
complements from the color wheel and varying the saturation and
brightness of one or both colors produces a very different result
from the pure complements. Combining a light tint of a warm
color with a darker shade of its cooler complement often gives
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pleasing results. Combining a darker shade of a warm color with a
light tint of its cooler complement produces an unusual effect that
may appeal to you.
Once you have mastered the concept of the color wheel, you have
a good framework for experimenting with color combinations.
Many books targeted at graphic designers show groups of
preselected color combinations. Some are organized by themes or
moods, and some are based on a custom color system, such as
PANTONE. The more you develop a critical facility for judging color
combinations, the more you will be able to trust your own eye for
color. The “Bibliography” on page B-119 at the back of this
manual includes books on design.
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Color and text
It is not a coincidence that the overwhelming majority of text you
see is printed in black on white paper. Text in black on white is
highly legible and is not fatiguing to read for extended periods.
For many color materials, using black text on a white background
and confining color to graphic elements and headings is a good
choice.
When used skillfully, color text can add flair to documents printed
on paper. This technique is widely used in presentations. When
using color text, avoid dazzling text and background combinations
created from primary complements, especially red and cyan or
red and blue; they are visually fatiguing and hard to read. Color
text is more legible when distinguished from its background by a
difference in lightness—for example, dark blue text on a light
beige background. In addition, using many different colors in a
string of text makes for a confused appearance and is hard to
read. However, using a single highlight color is an effective way to
draw the reader’s eye to selected words. For color text samples,
see the following figure.
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STOP!

STOP!

De gustibus
non est
disputandum.

Exceptio probat
regulam de rebus
non exceptis.

When using color text, keep in mind that small font sizes typically
do not print in color with the same sharpness as in black. In most
applications, black text prints exclusively in black toner, while
color text usually prints with two or more toners.
Any misregistration between the different toners on paper causes
color text to lose definition. You can make test prints to find the
smallest point size at which color text prints clearly. When using
high-end graphics applications that allow you to specify color as
percentages of cyan, magenta, yellow, black, you can create pure
cyan or pure magenta text that prints with the same sharpness as
black text. (Pure yellow text is extremely hard to read on anything
but a dark or complementary background.)

Raster images and vector graphics
Two broad categories of artwork can be printed from a personal
computer to a color printer: raster images and vector graphics.
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A raster image, also referred to as a bitmap, is composed of a grid
of pixels, each assigned a particular color value (as shown in
example a in the following figure). The grid, when sufficiently
enlarged, resembles a mosaic made from square tiles. Examples
of raster images include scans and images created in painting or
pixel-editing applications, such as Photoshop and Corel Painter.
The amount of data found in a raster image depends on its
resolution and bit depth. The resolution of a raster describes the
compactness of the pixels and is specified in pixels per inch (ppi).
The bit depth is the number of bits of information assigned to
each pixel. Black and white raster images require only one bit of
information per pixel. Grayscale images require 8 bits per pixel.
For photographic quality color, 24 bits of RGB color information
are required per pixel, yielding 256 levels of red, green, and blue.
For CMYK images, 32 bits per pixel are required.
When printing raster artwork, the quality of the output depends
on the resolution of the source raster. If the raster resolution is
too low, individual pixels become visible in the printed output as
small squares. This effect is sometimes called “pixelation.”
In vector graphics, picture objects are defined mathematically as
lines or curves between points—hence the term “vector” (see
example b). Picture elements can have solid, gradient, or
patterned color fills. Vector artwork is created in illustration and
drawing applications, such as Illustrator and CorelDRAW. Page
layout applications, such as QuarkXPress, also allow you to create
simple vector artwork with their drawing tools. PostScript fonts
are vector-based, as well.
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a

b

Vector artwork is resolution-independent; it can be scaled to any
size and resolution without danger of pixels becoming visible in
printed output.

Optimizing files for processing and printing
The following sections provide tips on how to create image files
that produce the highest possible print quality while minimizing
the processing time and disk space they require.

Resolution of raster images
While a 72-ppi raster image appears sharp on a monitor, the same
image would likely appear pixelated when printed to the Fiery.
Color printers are capable of much greater detail than computer
monitors, and require correspondingly higher resolution image
files. However, high-resolution files can be large and, therefore,
cumbersome to transmit over a network, process for printing,
store on disk, and edit.
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Beyond a certain threshold, a higher image resolution greatly
increases file size while having a minimal effect on output quality.
The optimal image resolution depends on the resolution of the
final print device. Aim for the resolution that optimizes both file
size and output quality.
The resolution of a raster image, along with its bit depth and
physical dimensions, determine its file size. The following table
shows the file sizes of color raster images at different dimensions
and resolutions.
File size at
Image size

100 ppi

150 ppi

200 ppi

400 ppi

600 ppi

RGB/
CMYK

RGB/
CMYK

RGB/CMYK

RGB/CMYK

RGB/CMYK

3" x 4"

0.4/0.5 MB

0.8/1.0 MB

1.4/1.8 MB

5.5/7.3 MB

12.4/16.5 MB

5" x 7"

1.0/1.3 MB

2.3/3.0 MB

4.0/5.3 MB

16.0/21.4
MB

36.1/48.1 MB

8.5" x 11"

2.7/3.6 MB

6.0/8.0 MB

10.7/14.3
MB

42.8/57.1
MB

96.4/128.5
MB

11" x 17"

5.4/7.1 MB

12.0/16.1
MB

21.4/28.5
MB

85.6/114.1
MB

192.7/256.9
MB

In this table, the shaded areas indicate that 200 ppi is typically
the best trade-off between image quality and file size. However,
higher resolutions (for example, 250 to 300 ppi) may be
necessary for offset printing, when quality is of the utmost
importance, or for images containing sharp diagonal lines.
To find the best image resolution for your purposes, make test
prints of some raster artwork at different resolutions. Start with a
high-resolution image (400 ppi) and save versions at
progressively lower resolutions, down to 100 ppi, using a pixelediting application, such as Photoshop. Always save a copy of the
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original high-resolution version, in case you must revert to it. The
high-resolution data cannot be recreated from a lower resolution
version.
Print the files and examine the output. You will likely begin to see
a marked deterioration in output quality at resolutions below
200 ppi, while above 200 ppi the improvement may be very
subtle.

Image quality

100

200

300

400

500

600

Image resolution

Raster images prepared for offset printing may need to be at
higher resolutions than necessary for proofing on your Fiery.

Scaling
Ideally, each raster image should be saved at the actual size, and
it will be placed in the document at the optimal resolution for the
printer. If the image resolution is correct for the printer, there is
no quality advantage to be gained by scaling an image to a
percentage of its actual size. If you scale a large image to a
percentage of its actual size, you incur unnecessary file transfer
time, because the image data for the entire large image is sent to
the printer. If an image is placed multiple times at markedly
different sizes in a document, save a separate version of the
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image at the correct size for each placement.
If you need to place an image at greater than 100% in a
document, remember that the output image resolution is affected.
For example, if you scale a 200 ppi image to 200%, the image is
printed at 100 ppi.

Sharp AR-C360P EFI Color Reference Guide - 108

G-109

Glossary
additive color model

A system in which colors are produced by combining red, green, and blue light (the
additive primaries). An RGB video monitor is based on an additive color model.
additive primaries

Red, green, and blue light used in additive color systems. When blended together in
proper amounts, these colors of light produce white.
artifact

A visible defect in an image, usually caused by limitations in the input or output process
(hardware or software); a blemish or error.
banding

Visible steps between shades in a color gradient.
bit depth

Amount of information used for each pixel in a raster image. Black and white images
require only one bit per pixel. Grayscale images with 256 shades of gray require 8 bits (or
1 byte) per pixel. Photographic quality color images can require 24 bits per pixel (RGB
images) or 32 bits per pixel (CMYK images).
bitmap (or raster)

An image comprised of small squares arranged in a grid. Each square in the grid is a
pixel. The number of pixels per inch defines the resolution of a bitmap.
blasting

An undesirable effect that occurs when excess amounts of toner, possibly combined with
certain types of paper stock, cause objects in an image to spread beyond the boundaries
defined in the file.
BMP

A graphics file format established by Microsoft; native to the Windows operating system.
calibration

The process of ensuring that a device behaves consistently with respect to a set of
specifications.
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calibration target (or calibration set)

A set of measurements that describe the expected density response of a printing device.
Calibration targets are associated with the output profile of the device.
CMS

See color management system.
CMYK

A subtractive color model that uses cyan, magenta, yellow, and black, or process colors,
used in color printing; a color model used in the printing of colors in four-color process
printing.
color channel

A single-color image that can be edited separately from the other color channels
comprising a color space—for example, the red channel of an RGB image.
color gamut

See gamut.
color management system (CMS)

System used to match color across different input, display, and output devices.
color rendering dictionary

See CRD (Color Rendering Dictionary).
color separation

The process of separating a color image into the color components for printing—cyan,
magenta, yellow, and black. Also used to refer to the four sheets of film that result from
the process of separating a color image.
color space

A model for representing color in terms of measurable values, such as the amount of red,
green, and blue in an image. RGB and CMYK color spaces correspond to color devices—
monitors and printers, respectively. Other color spaces, such as CIE Lab, are based on
mathematical models and are device-independent (that is, not based on the color
response of a particular device). See gamut.
colorant

An ink, dye, toner, paint, or other pigment that modifies the color of media to which it is
applied.
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ColorWise

See ColorWise color management.
ColorWise color management

An ICC-open color management solution, which is an easy-to-use system that addresses
the needs of both casual and experienced color management users.
composite printer

Any output device that can print directly in color without first creating color separations.
A composite print can be used as an early proof of an offset print job.
continuous tone (contone)

Describes a photographic image that contains gradient tones from black to white (such as
a 35mm transparency or a photograph). Continuous tones cannot be reproduced in that
form for printing, but must be screened to translate the image into dots.
continuous tone (contone) image

An image containing fine gradations of tones, such as a photographic image.
CRD (Color Rendering Dictionary)

A feature of color management systems and PostScript Level 2 and PostScript 3 color
devices that maintains the best possible translation of color from one color device to
another. A color rendering dictionary (CRD) is used by the color management system or
the device’s PostScript interpreter when converting data between color spaces. The Fiery
includes several CRDs, each of which provides a different color rendering style.
custom color system

A system of named color swatches that can be matched on press using spot colors or
approximated using process colors. PANTONE and TruMatch are examples of custom color
systems.
DCS (Desktop Color Separation)

A data file standard defined by Quark, Inc., to assist in making color separations with
desktop publishing systems; five files are created—four color files (one each for C, M, Y,
and K) and a composite color preview file of the color image. It allows an image-editing
application to perform color separation and pass it through to final output with its
integrity intact.
densitometer

An instrument commonly used in the graphic arts industry to measure density according
to a specified standard.
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density

A measurement of the light-absorbing quality of a photographic or printed image.
desktop color separation

See DCS.
DIC

A Japanese standard of specifications for separations, proofs, and color printing.
EPS (or EPSF)

See Encapsulated PostScript.
Encapsulated PostScript

A PostScript file format designed to be embedded in another PostScript stream.
Euroscale

A European standard of specifications for separations, proofs, and color printing.
flexography

A printing technology that uses flexible raised-image plates. Flexography can be used to
print on non-flat materials such as cans.
four-color printer

A printing device that uses cyan, magenta, yellow, and black ink or toner.
gamma

A numeric value representing the relationship (gamma curve) between the input and
output values of a color device. If gamma equals 1, input values are mapped exactly to
output values.
gamut

A range of colors. A device gamut is the range of colors that a device, such as a device,
can produce. An image gamut is the range of colors in a particular image.
gamut mapping

The conversion of color coordinates from one device’s gamut to another—usually
accomplished with algorithms or look-up tables.
GCR

See gray component replacement.
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GDI (Graphics Device Interface)

Graphics and display technology used by computers running Windows. GDI applications
rely on GDI (rather than the PostScript language) to send text and pictures to devices.
GIF (Graphics Interchange Format)

A standard developed by CompuServe for bitmap graphics of up to 256 colors and used
for posting photographic images on the Internet or intranet pages; rarely used for
professional printing.
gradient

A smooth transition between two different colors or two shades of a color.
Graphics Device Interface

See GDI.
Graphics Interchange Format

See GIF.
gravure

A printing technology that uses an etched cylinder that has been immersed in ink. The ink
that remains in the etched areas is applied to the paper. The non-etched surfaces of the
cylinder are non-printing areas.
gray component replacement (GCR)

A method for improving wet ink trapping and reducing ink costs in process color printing.
In shadow, midtone, and quarter-tone areas where all three process colors (C, M, Y)
overprint, the gray components of those colors are reduced and replaced by black.
halftoning

A method for representing an original continuous tone image using a pattern of dots,
lines, or other patterns.
HSB

A color model where each color is represented by its hue, saturation, and brightness
components; supported by most color applications.
HSL

A color model where each color is represented by its hue, saturation, and lightness
components.
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ICC profile

An industry standard color profile format developed by the International Color
Consortium (ICC) that describes the color capabilities, including the gamut, of a color
device based on the differences between an ideal and the current device. The ideal is
often provided by the manufacturer as a color reference file. ICC profiles are
implemented on Mac OS computers in ColorSync and on Windows computers in Image
Color Matching (ICM). The Fiery color management system, ColorWise, supports ICC
profiles.
imagesetter

Raster-based film output device; a high-resolution laser output device that writes
bitmapped data onto photosensitive paper or film.
JPEG

A graphics file format defined by the Joint Photographic Experts Group committee of
International Standards Organization (ISO); a standard for digital compression of still
image graphic data.
metamerism

Phenomenon in which two colors composed of different combinations of light wavelengths
appear identical under a specific light source, but may look different under other light
sources. The colors are called “metamers.”
moiré

An undesirable pattern in images made using halftone screens. Moiré can be caused by
the improper line frequency of the screens, improper screen angles, improper alignment
of halftone screens, or by the combination of a halftone screen with patterns in the image
itself.
named color

A color that is defined according to a custom color system. For example, PANTONE 107 C
is a named color. (Also referred to as a spot color).
office applications

Software applications commonly used for business purposes, including presentation
applications, spreadsheets, and word processing programs.
offset lithography

Printing in which ink is transferred from printing plates to a rubber blanket and then from
the blanket to paper.
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output

See output profile.
output profile

A file that describes the color characteristics of a printing device. The output profile is
associated with a calibration target that defines the expected density response of the
device.
phosphor

Material used in making computer monitors; phosphors glow and emit red, green, and
blue light when struck by an electron beam, thus creating an image.
photographic rendering

A color rendering style that preserves tonal relationships in images. Unprintable colors
are mapped to printable colors in a way that retains differences in lightness, sacrificing
color accuracy as necessary.
pixel

The smallest distinct element of a raster image. The term is a combination of the words
“picture” and “element.”
PostScript

A device-independent page description language developed by Adobe, which is used to
print and display pictures and text. PostScript 3 includes many enhancements to older
versions of PostScript, including improved image quality and color.
PPD (PostScript Printer Description file)

A file containing information about a particular PostScript print device’s capabilities and
restrictions. The information in the PPD is presented via the printer driver.
prepress proof

A print made from a set of film separations or other file to simulate the results of printing.
A prepress proof is the last opportunity to catch problems before the print job goes to
press.
presentation graphics rendering

A color rendering style that creates saturated colors but does not match printed colors
precisely to displayed colors. It is appropriate for bright saturated colors used in
illustrations and graphs.
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process colors

The colors used in printing to simulate full-spectrum color images: Cyan, Magenta,
Yellow, blacK (CMYK).
profile

Systematically describes how a color maps to a particular space. By identifying a source
profile and an output profile, you initiate the appropriate workflow to maintain consistent
color values.
QuickDraw

Graphics and display technology built into Mac OS computers. QuickDraw applications
rely on QuickDraw (rather than the PostScript language) to send text and pictures to
devices.
raster image

Electronic representation of a page or image using a grid of points called pixels.
rendering intent

The style of color rendering, or gamut mapping, designed for a particular type of color
job. An example of a rendering intent is Photographic rendering—also referred to as
Image rendering or Contrast rendering—which is designed for photographic images.
resolution

The number of pixels per inch (ppi) in a bitmap image or the number of dots per inch
(dpi) that a device can render.
RGB

An additive color model that makes a range of colors by combining red, green, and blue
light, called the additive primaries. Commonly used to refer to the color space, mixing
system, or monitor in color computer graphics.
simulation

See simulation profile.
simulation profile

The simulation profile describes the color characteristics of another print device, such as
a printing press, that you want the Fiery to simulate.
solid color rendering

A color rendering style intended for use when color accuracy is crucial. Unprintable colors
are mapped to the closest printable colors. Solid color rendering does the best job of
preserving the saturation of displayed colors.
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source color space

The color environment of the originating source of a colored element, including scanners
and color monitors.
source profile

A file used by the color management system to determine the characteristics of the color
values specified in a source digital image.
spectral light

The wavelengths of electromagnetic radiation emitted by a given light source that can be
seen by the human eye.
spectrophotometer

An instrument commonly used in the graphic arts industry to measure spectral light
according to a specified standard.
spot color

A color printed on its own separation plate when separations are specified. A spot color is
printed using a custom ink for that color, in contrast to process colors that are printed
using combinations of cyan, magenta, yellow, and black. (Also referred to as a named
color).
Status T

A spectral response for graphic arts reflection densitometers defined by ANSI (American
National Standards Institute).
subtractive color model

A system in which color is produced by combining colorants such as paint, inks, or dyes
on media such as paper, acetate, or transparent film. All printing devices use the
subtractive color model.
subtractive primaries

Cyan, magenta, and yellow colorants used in subtractive color systems for color printing.
Combining the subtractive primaries produces darker colors. Black is added to the
subtractive primaries to compensate for deficiencies of the toners or inks, and for more
efficient black printing.
substrate

In printing, the material upon which the job is printed.
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SWOP

The abbreviation for Specifications for Web Offset Publications. A standard of
specifications for separations, proofs, and color printing on a web offset press (not a
sheet fed press).
TIFF (Tag Image File Format)

A common format for exchanging raster graphics (bitmap) images between application
programs.
undercolor removal (UCR)

A method for improving wet ink trapping and reducing ink costs in process color printing.
In shadow areas where all three process colors (C, M, Y) overprint, the amounts of those
colors are reduced and replaced by black.
vector graphic

Graphic illustration created on computers where picture objects are defined
mathematically as lines or curves between points. These mathematical definitions are
interpreted by an image language such as PostScript. Vector images include artwork
created with illustration applications (such as Illustrator or FreeHand) and page layout
applications (such as PageMaker).
white point

The color temperature of any white light source, typically expressed in degrees Kelvin (for
example, 6500 K, typical for the white of a monitor).
workflow

The path a print job follows from creation to destination. A workflow may originate with
an RGB scan imported to the client workstation and opened on the desktop in an image
processing application, such as Photoshop. After adjustments are made to the scanned
image, it is evaluated on a color proofing device for eventual color printing on the same
device or on press.
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photographic
transparencies A-94, A-96
Photoshop
color management with 4-33

EFI Color Reference Guide for Sharp AR-C360P - 122

I-123

Index

importing CorelDRAW
data 7-86
using 5-42 to 5-55
Photoshop Multi-channel 5-54
physics of color A-88
pixel-editing
applications A-104, A-106
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RGB Color Reference 1-17, 3-29
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saturation A-88, A-91
scaling of raster images A-107
scanners A-93
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Separations, printing with
Photoshop 5-49
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simulation, see CMYK Simulation
option
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Spot Color Matching option
with Photoshop 5-54
with PostScript
applications 4-35
spot colors 4-33, 4-34, A-98
sRGB 5-43
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subtractive color
model A-93, A-94
subtractive primaries A-94
sunlight A-88
swatch color matching 4-34

T

text
font size A-103
using color with A-102
TIFF images
assigning ICC profiles to 4-39
preview 5-48
printing at full resolution 6-66
recommended for imported
images 4-39, 5-46
tint A-91
transparencies
(photographic) A-94, A-96
triads A-100

V

vector images A-103, A-104
visible spectrum of light A-88

W

white point 1-15
Windows Graphics Device
Interface, see GDI applications
Word, see Microsoft Office
workflow, recommended 2-22
working space
Illustrator 7-73, 7-75
Photoshop 5-42
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